
Oracle Fusion
Cloud Applications

Using Common Features

26C



Oracle Fusion Cloud Applications
Using Common Features

26C

G56209-01

Copyright © 2011, 2026, Oracle and/or its affiliates.

Author: Barnali Roy, Essan Ni Jirman, P. S. G. V. Sekhar, Rebecca Nethala, Kalyani Manda

https://docs.oracle.com/pls/topic/lookup?ctx=en%2Flegal&id=cpyr&source=


Oracle Fusion Cloud Applications
Using Common Features

Contents

Get Help ................................................................................................................................  i

1 Get Started 1
About This Guide ............................................................................................................................................................................   1

Oracle Fusion Cloud Applications System Requirements ......................................................................................................   1

Sign In and Get Started ................................................................................................................................................................   2

Sign Out and Session Timeout ...................................................................................................................................................   5

Overview of Work Areas ...............................................................................................................................................................   7

Change Your Password ................................................................................................................................................................  10

Set Up Multifactor Authentication Methods ...........................................................................................................................   11

FAQs for Getting Started .............................................................................................................................................................  12

2 Search 15
Overview of Search ......................................................................................................................................................................   15

Global Search .................................................................................................................................................................................   15

Page-Level Search ........................................................................................................................................................................   18

3 Watchlist 23
Overview of Watchlist ..................................................................................................................................................................  23

Create Watchlist Items .................................................................................................................................................................  23

FAQs for Watchlist ........................................................................................................................................................................  24

4 Notifications and Approval Workflows 25
Overview of Notifications and Approval Workflows .............................................................................................................  25

Actions and Statuses for Workflow Tasks ..............................................................................................................................   26

View and Act On Notifications ..................................................................................................................................................  28

Use Your Worklist to Manage Workflow Tasks .......................................................................................................................   31

Use the Approvals Work Area to Manage Approvals ...........................................................................................................   33

Define Vacation and Other Rules for Workflow Tasks Assigned to Me ............................................................................  35

FAQs for Notifications and Approvals .....................................................................................................................................   38

Monitor and Troubleshoot Transactions ................................................................................................................................   40



Oracle Fusion Cloud Applications
Using Common Features

5 Tables 49
How You Use Tables ....................................................................................................................................................................  49

Query By Example ........................................................................................................................................................................   51

Export to Excel ..............................................................................................................................................................................   53

6 Excel Add-Ins 55
Oracle ADF Desktop Integration Add-In for Excel ................................................................................................................   55

Oracle Visual Builder Add-In for Excel ....................................................................................................................................   57

7 Attachments 59
How can I delete attachments? ................................................................................................................................................   59

Can I view attachments in a different format? ......................................................................................................................  59

How can I filter attachments? ...................................................................................................................................................   59

What happens if I update an existing attachment? .............................................................................................................   59

8 Data on Application Pages 61
How can I print the data in the page I am on? ......................................................................................................................  61

Why can't I see all the values I expect in my list of values? ...............................................................................................   61

How can I locate flexfields on a page? ....................................................................................................................................   61

How can I enter or edit translated text in Fusion Applications? ........................................................................................   61

What's the difference between Language and Source Language? ...................................................................................  62

Why does the Date field display a different value than my preferred date? ...................................................................   62

How's user personalization enabled in Redwood application pages? ..............................................................................   62

9 Scheduled Processes 65
What are scheduled processes? ...............................................................................................................................................   65

Process Sets ..................................................................................................................................................................................   66

Submit Processes .........................................................................................................................................................................  66

Manage Processes and View Output ......................................................................................................................................   70

FAQs for Scheduled Processes ..................................................................................................................................................   81

Where to Find Information About Specific Scheduled Processes .....................................................................................  86

Where to Find Information About Common Scheduled Processes ..................................................................................   87

10 Transactional Business Intelligence (OTBI) Analyses, Dashboards,
Reports, and Infolets

91

Reporting and Analytics: Overview of Analyses, Dashboards, Reports, and Infolets ....................................................   91



Oracle Fusion Cloud Applications
Using Common Features

View Analytics, Reports, and Dashboards ..............................................................................................................................   92

Where to Find More Information About Analytics and Reports ........................................................................................  94

Infolets ............................................................................................................................................................................................   95

11 Audit 99
Audit Reports ................................................................................................................................................................................   99

View Audit Reports ....................................................................................................................................................................   100

Why is Last Update Date Different from Creation Date? ...................................................................................................   101

Why can’t I see all the records in the generated report? ...................................................................................................  102

Can I get an Audit Report on changes made to the Audit Policy? ..................................................................................   102

Why are unchanged columns showing up in the Audit Report? .....................................................................................   102

12 Troubleshoot 105
Troubleshoot Issues ...................................................................................................................................................................   105

Diagnostic Tests ..........................................................................................................................................................................  105

Record Issues to Troubleshoot ..................................................................................................................................................  111

FAQs for Troubleshooting ..........................................................................................................................................................  112

13 Help 115
Get Help in the Application .......................................................................................................................................................  115

Find Guides, Readiness Material, and Other Resources .....................................................................................................  116

14 Preferences 119
Set Your General Preferences ...................................................................................................................................................   119

Set Language Preferences ........................................................................................................................................................   119

Set Regional Preferences ...........................................................................................................................................................  119

Change Your Photo ....................................................................................................................................................................   120

Set Up the Accessibility Modes ...............................................................................................................................................  120

Change Your Password ...............................................................................................................................................................  121

Set Up Multifactor Authentication Methods .........................................................................................................................  122

Watchlist ........................................................................................................................................................................................   123

15 Accessibility 125
Overview of Application Accessibility ....................................................................................................................................   125

Accessibility Features .................................................................................................................................................................  125



Oracle Fusion Cloud Applications
Using Common Features

Keyboard Shortcuts ....................................................................................................................................................................   126



Oracle Fusion Cloud Applications
Using Common Features

Get Help

Get Help
There are a number of ways to learn more about your product and interact with Oracle and other users.

Get Help in the Applications
Some application pages have help icons    to give you access to contextual help. If you don't see any help icons on
your page, click your user image or name in the global header and select Show Help Icons. If the page has contextual
help, help icons will appear.

Get Training
Increase your knowledge of Oracle Cloud by taking courses at Oracle University.

Join Our Community
Use Cloud Customer Connect to get information from industry experts at Oracle and in the partner community. You
can join forums to connect with other customers, post questions, suggest ideas for product enhancements, and watch
events.

Share Your Feedback
We welcome your feedback about Oracle Applications user assistance. If you need clarification, find an error, or just
want to tell us what you found helpful, we'd like to hear from you.

You can email your feedback to oracle_fusion_applications_help_ww_grp@oracle.com.

Thanks for helping us improve our user assistance!
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1  Get Started

About This Guide  
This guide is for anyone who's using the application, which means you! Use it to learn how to do general tasks that
apply to some or all product families. If you're looking for product-specific information, refer to the product-specific
guides.

Note:  You might come across information in this guide that applies only to certain pages or products.

Oracle Fusion Cloud Applications System Requirements  
Before using Fusion Applications in browsers and on your mobile devices, check the operating systems, supported
browsers, and other computer requirements.

Here are the minimum versions you need for your browsers.

Browser Minimum Version

Apple Safari 18.5

Google Chrome 138

Microsoft Edge 138

Mozilla Firefox 140

Oracle supports all the platforms that the browser vendor supports, as indicated in this table. For mobile device
operating systems, Oracle supports only the most recent browser.

Operating System Apple Safari Google Chrome Microsoft Edge Mozilla Firefox

Android Not applicable Supported (Chrome for
Android only, not native
Android browser)

Not applicable Not supported

iOS/iPadOS Supported Not supported Not supported Not supported

Mac OS X Supported Supported Not supported Supported

Windows Not supported Supported Supported Supported

1
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Other Requirements
To use the Oracle ADF Desktop Integration add-in for Excel, you need the appropriate Windows and Excel versions. See:
Supported Platforms for ADF Desktop Integration (Doc ID 2242428.1).

Sign In and Get Started  
Use the application link your company gave you to open the Sign In page. Sign in using your assigned application user
ID and password. Your user ID may be in the form of a user name, email address, phone number, or another format. If
your company uses Single Sign-On (SSO), one of these options might also be available to you:

• Click the Company Single Sign-On button and sign in using your SSO credentials.

• Click the Sign in with... button you see after the Next button and sign in using your SSO credentials.

By using SSO, you can seamlessly access different applications without the need to authenticate yourself each time.

Watch video
 

How can I quickly go to the page I'm looking for to do my tasks?
Here's what you can try:

• Global Search: Enter the search keyword in the global search field to find what you want to work on and open
the corresponding page from the search results.

If you don't get what you're looking for in the search, try the Navigator.

• Navigator: Click the Navigator icon on the global header and select the required work area.

Tip:  If you're not sure which category to look under, click Show More to see all the work areas in all
categories.

Keep reading to learn more about the search, the Navigator, and other options for getting to your page.

Home Page
Your home page shows a global header, which you can find on every page of your application. The global header
contains some icons, the Navigator, and your user image or name. You can use them to get to the tasks you want to
accomplish. You can click your user image or name to open the Settings and Actions menu.

You can use the work area icons in the Apps section of your home page to get to the work areas and do your tasks. If
you don't find any work area icons in the Apps section, look for them in the Navigator. That's because the Navigator
contains the full list of work areas that you've access to. Related work area icons are arranged in specific groups in the
Navigator. These groups appear as tabs in the Apps section.

Here's how your home page looks.

2
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Callout Number UI Element What You Use It For

1
 

Navigator
 

Open any of the work areas that you've access
to.
 

2
 

Other global header functionality
 

Use tools such as Global Search, Watchlist, and
Favorites to see or get to what you need to work
on. At any point, if you want to return to your
home page from any page, you can click the
Home icon or the logo in the global header.
 

3
 

Settings and Actions menu
 

To open this menu, click your user image or
name in the global header. Do some general
tasks, for example, change your preferences,
 show help icons if they're hidden, and sign out.
 

4
 

Tabs
 

See a set of work area icons and quick actions
for a related set of tasks. These tabs correspond
to groups in the Navigator.
 

5
 

Work area icons in the Apps section
 

Open your work areas from the group of icons
on the home page. For example, click the
Getting Started icon to open the Getting
Started work area, where you can see materials
that help you get going in the application. You
can also show or hide specific work area icons
using the Personalize Springboard icon.
 
Here are a few things to know:
 

• What icons you see in the Apps section
depends on the tab you select.

• If you're looking for any standalone work
area, such as Setup and Maintenance,
 check in the Others tab.

• If you can't see any tabs, it means you just
have one visible group. In such cases, all
work area icons in that group appear at
the top level in the Apps section.

3
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Callout Number UI Element What You Use It For

6
 

Quick Actions section
 

Go straight to some key tasks in the selected
group. You can use Show More to see all quick
actions in each group sorted alphabetically.
 

Note:  You might see changes in icons, colors, and shapes of some UI components.

You might also find some important information displayed in specific sections of your home page. This table lists the
sections and describes what you use them for.

Section What You Use It For

Things to Finish
 

View a list of your open notifications, and take required actions. For example, you can approve or reject
a new notification even without opening it.
 

News and Announcements
 

Read all relevant news, such as articles, events, and insights.
 

Note:
What information you see in this section depends on your user role.
 

Analytics
 

View infolets, usually shown in tabs. If you see an infolet's content at the top level (without any tabs),
 that means you've just one visible infolet.
 
An infolet is a small interactive widget that gives you key information and shows you what's going on
in the areas you work on. You might also find something that you need to follow up on.
 

Note:  If you see different section names in your home page, that's because your administrator renamed them while
setting up your home page.

Ways to Find Key Tasks in the Global Header
Let's take a closer look at how to find key tasks using the icons in the global header.

Callout Number UI Element What You Use It For

1
 

Global Search
 

Find what you want to work on and open the
corresponding page from the search results.
 

2
 

Home
 

Return to the home page.
 

3
 

Favorites and Recent Items
 

Bookmark pages or go back to those you
recently opened.

4
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Callout Number UI Element What You Use It For

 
In some cases, when opening a favorite or
recent item, you might encounter an issue
where it doesn't open the exact page you
expect. For instance, instead of directing you to
a specific page, it might open the search page.
 

4
 

Watchlist
 

Open pages for key items that you're tracking.
 

5
 

Notifications
 

See informational messages and tasks that you
must act on.
 

6
 

Settings and Actions menu
 

To open this menu, click your user image or
name in the global header. Here are a few tasks
you can do using this menu:
 

• Set your preferences. For example, change
your password or set your language and
accessibility preferences.

• Help troubleshoot problems if you run into
any.

The options you see in this menu depend on
your role. For example, an administrator can
see more options to configure the application.
 

Note:  The Search, Favorites and Recent Items, and Watchlist features aren't available for all pages. In some work
areas, such as Functional Setup Manager, the Favorites and Recent Items icon may not work as expected. See Why
am I not able to save a Functional Setup Manager task page to my favorites list?

Related Topics
• Change Your Photo

• How You Use and Personalize Infolets in Oracle Fusion Cloud SCM and Procurement

• Keyboard Shortcuts for Home Page

• How can I configure how infolets are displayed in Fusion Applications?

Sign Out and Session Timeout  
After you complete your tasks, you can sign out of your application. However, sometimes you might get automatically
signed out due to session timeouts.

5
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Sign Out
When you're done working in your application, you can sign out using the Settings and Actions menu. Click your user
image or name in the global header to open this menu, and select Sign Out and then click Confirm to sign out of the
application.

Session Timeout
Let's understand how session timeouts work. When you sign in using your credentials, you're authenticated to use
the application, and a session is established. During this session, you don't need to re-authenticate. But, for security
purposes, your session is configured to be active for a predefined duration, which is called session timeout period. Your
sessions can expire due to various reasons such as, leaving your application idle for a period longer than the timeout
period. In such cases, you're automatically signed out of the application. Your timeout periods may vary on certain
pages. For example, you may observe a longer timeout period on pages that automatically refresh, or UIs that open up
in separate windows or tabs.

This table lists the various types of session timeouts you may experience. After the specified duration, your session
expires, and you need to sign in again to continue your work.

Note:  Session timeouts are predefined and can't be edited.

Timeout Type Description Timeout Duration

Session Lifetime Timeout
 

Once you're authenticated in the application,
 if you're actively working on it, your session
remains active for a predefined duration,
 referred to as the session lifetime timeout
period.
 
Your session ends after this period, even if
you're using the application.
 

8 hours
 

Session Inactivity Timeout
 

This type of timeout considers the time elapsed
since you last sent a request, for example
responded to a poll or submitted a form, to the
application server.
 
After this duration, you get a message and
an option to extend the session. If you don't
extend the session, you're signed out of it.
 

10 minutes
 

Idle Session Timeout
 

This type of timeout considers the duration
you leave your application idle for. After this
duration, you get a message and an option to
restart the session.
 

• If you restart the session, your session
timeout duration gets reset.

• If you don't restart the session, you're
signed out of the application.

120 minutes
 

Browser Inactivity Timeout
 

This type of timeout considers the duration you
leave your browser idle for. After this duration,
 your session ends.

30 minutes
 

6
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Timeout Type Description Timeout Duration

 

How Different Session Timeouts Work
If you're actively working on your application, your session remains active until the session lifetime timeout period,
which is eight hours. However, session inactivity timeout considers the time elapsed since you last sent a request to
the application server. For example, responded to a poll or submitted a form. These requests are sent to the server at
regular intervals and the session inactivity timeout will not happen. But here are a few scenarios when the poll or active
data service requests will be stopped, and the browser inactivity timeout happens.

• If you leave your browser idle for more than 30 minutes.

A warning appears informing you that the session has ended and you're signed out of the session. You need to
sign in again and the home page is displayed.

• If you don't use the keyboard or mouse for more than 10 minutes. For example, if the server-side session
timeout is 30 minutes, and the polling timeout parameter is set to 10 minutes, then the timeout events take
place in the following sequence:

◦ The session inactivity timeout starts during the polling time of 10 minutes.

◦ In the next 30 minutes, the idle session timeout begins.

◦ During the idle session timeout period, a session expiration warning message is displayed at the 28th
minute. You’ll be given 2 mins to reset the session timeout. If you reset the session, the current page will
be displayed. At the end of the 30th minute, if you’re still inactive, the session expires and you’ll be signed
out. You need to sign in again and the home page is displayed.

Best Practices for Minimizing Timeouts
Here are a few things to keep in mind:

• Sign in to only one active application instance.

• Don't sign in to the application in multiple browsers simultaneously.

• Don't sign in to the application in multiple tabs of the same browser simultaneously.

Overview of Work Areas  
A work area is a set of pages that provides everything you need to accomplish a business goal.

Watch video
 

You can use work area icons on your home page or the Navigator to open work areas. When you open any work area,
you see a landing page. Landing pages typically summarize data and let you drill down to more details. Often you can
change the records that you view by running different searches or filters, or by clicking an infotile, if any on the landing
page. Let's explore a couple of work areas.

7
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Landing Pages with Searches and Filters
Some landing pages have filters you can use to view specific set of records that you're looking for. For example, you can
remove some values to exclude records that you don't want to see, and then hide the filters. You can also use the search
to find what you need. You can select the Actions menu to get going with a few tasks on the specific records, or open
the record to see or edit details on another page.

Here's a landing page of a work area, where you use searches (1) and filters (2) to view specific records, and the Actions
menu (3) to do your tasks.

Sometimes, you might find this record in the form of a grid or list. You can use the Grid icon and the List icon to switch
between these two views of the same records.

Landing Pages with Quick Access to Key Tasks
Now let's see another work area where you get quick access to a set of related tasks. On these landing pages, you easily
see the key tasks you can do in the work area.

Here's a landing page of a work area, where you can quickly access the key tasks (1).

8
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Landing Pages with Infotiles
Other than filters and searches, there are other ways for you to get to what you need to work on.

Some landing pages show the work areas with infotiles, which display key information about a set of records. You can
click links in the infotile to filter the records. For example, you can see the list of items you need to act on.

This table shows the available UI elements on the landing page and explains what you use them for.

Callout Number UI Element What You Use It For

1
 

Row of infotiles
 

Display key information about a set of records,
 such as expense items and expense reports.
 

2
 

Summary table
 

• View records for the infotile you select.

• Drill down from the landing page to a
specific record.

3
 

Panel tab
 

Do additional tasks, such as use the links to go
to related tasks or view reports.
 

Some landing pages have tabs on the left you can use to go to another page in the same work area.

Here's a landing page of a work area with tabs on the left (1).

9
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Landing Pages with Infolets
Some landing pages consist of only infolets. This is what a landing page with infolets looks like.

This is what a landing page with infolets looks like.

From an infolet, you can usually open other pages in the same work area or another work area.

There are many other types of work areas, which you can explore!

Related Topics
• Sign In and Get Started

• How You Use Tables

• How can I show or hide work area icons on my home page?

• Overview of Infolets

Change Your Password  
Use the application link your company gave you to open the Sign In page and change your password for better security.
You can use either of these methods to change your password.

• After you sign in, you can change your password using the Set Preferences option.

• On the Sign In page, you can change your password using the Forgot Password link.

Change Your Password Using Set Preferences
1. Click your user image or name in the global header, and on the Settings and Actions menu, select Set

Preferences.
2. In the General Preferences section, click Password, and enter your password details.
3. Click Save and Close.

Change Your Password Using Forgot Password
1. On the Sign In page, click the Forgot Password link.
2. Enter the registered work email, select the Forgot Password option and click Submit.

10
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A notification containing a link to reset your password is sent to your work email.

Note:
• If you don’t have your work email registered, the notification is sent to your line manager.

• If both you and your line manager don’t have work emails registered, you’ll not be able to reset your password.
Contact your security administrator to register your work email.

This table shows which method you can use for resetting passwords based on your Single Sign-On (SSO) configuration.

Password Reset Method to UseSSO Configuration

Set Preferences Option Forgot Password Link

SSO Disabled Yes Yes

SSO Enabled No No

SSO with Chooser Enabled (both SSO sign-in and local
authentication options are available)

No Yes

Set Up Multifactor Authentication Methods  
Setting up multifactor authentication (MFA) methods is either optional or mandatory for you, based on the environment
you're in. After a method is set up, you can use it as a second factor of authentication for signing in.

Enroll in MFA and Set Up Your First Authentication Method
1. Sign in to the application using your application user ID and password. If mandatory MFA applies to you, skip to

step 4.
2. Click your user image or name in the global header, and select Set Preferences from the Settings and Actions

menu.
3. Open your password preferences and click Manage Secure Verification.
4. Enable secure verification using any of the available methods. You go through this guided setup process only

when you're enrolling in MFA for the first time.

Method Action Required

Mobile App Use either of these modes.

◦ Set up the Oracle Mobile Authenticator App to send a push notification for allowing or
denying a sign in attempt.

◦ Set up the Oracle Mobile Authenticator App to generate a passcode.

Phone Number Verify using the one-time passcode that's sent to your phone number as a text message.

Email Verify your email address using the one-time passcode that's mailed to you.

11
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Method Action Required

Passkey Follow the on-screen instructions to configure a passkey for your device.

Note:  Your work mobile number and work email are used for the Phone Number and Email methods.
The mobile number and email are stored in Oracle Fusion Cloud Applications and not in Oracle Cloud
Infrastructure.

Set Up Additional Methods and Manage Them
After you enroll in a MFA factor, you can set up additional secure verification methods on the Security tab that opens in
Oracle Cloud Console. Any time after enrollment, you can click the Manage Secure Verification link in your password
preferences to return to the Security tab and set up additional secure verification methods or manage them.

Bypass codes are available as an additional authentication option. You can generate a bypass code and save it for
later use, but you can use it only once. A bypass code comes in handy for you to sign in when your authenticator is
unavailable for any reason like lost service or no service. You can also contact your administrator to get a bypass code.

After entering the username and password, if you can't use the MFA factor that was enrolled earlier, select the Try
another way button to view the other MFA factors that are available for use. On selecting the Try another way button,
from the remaining MFA factors that are available for you, select the MFA factor that you can use to sign-in to the
application.

Select the Trust this device for 15 day(s) option to access the application without getting prompted to verify every time
you sign-in, for the specified number of days.

Related Topics
• Using the Oracle Mobile Authenticator App

• Using FIDO Authentication

• Generating a Bypass Code

FAQs for Getting Started  

What do I do if I can't find work area icons on the home page or
the Navigator?  
Here are a few things to know.

• If you can't find a work area icon on the home page, look for it on the Navigator. The Navigator is the main
menu, where you can open all the work areas you have access to.

• You might not find some work area icons on the home page or the Navigator because your administrator has
disabled those work areas.

• If you're looking for any standalone work area, such as Setup and Maintenance, check in the Others tab.

12
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• If you need access to a specific work area, ask your security administrator to assign you a role that gives you
access.

Related Topics
• Create and Edit Groups

How can I show or hide work area icons on my home page?  
You can show or hide the work area icons that you use to navigate in the application.

Click the Personalize Springboard icon on the home page, and select or deselect the work areas icons to show or hide
them.

Related Topics
• Sign In and Get Started

How can I reset my changes to the visibility settings of the work
area icons on my home page?  
In the Apps section of your home page, click the Personalize Springboard icon, and then on the Apps page, click
Reset.

Related Topics
• How can I show or hide work area icons on my home page?

Why can't I see icons in the global header?  
You may not see the Favorites and Recent Items and Watchlist icons because they aren't available for certain product
families. However, if you can’t see any icon on the global header, that’s probably because of the colors that your
administrator selected for the global text and icons while setting the appearance of your application.

Related Topics
• Appearance Settings for Classic Themes

Why am I not able to save a Functional Setup Manager task page
to my favorites list?  
Probably, you have opened the task using the Setup and Maintenance work area.

13
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To mark a Functional Setup Manager task page as favorite, as a one-time process, open the task using the Offerings
work area. After you mark a task as favorite, you can access it directly from the Favorites and Recent Items list.

1. Click Navigator  > My Enterprise > Offerings.
2. On the Offerings page, select the offering you want to implement.
3. Click Opt In Features.
4. Click on the Setup icon for the required feature or functional area.
5. Search for and open the task.
6. On the task page, click the Favorites and Recent Items icon to add the page to your favorites list.

Related Topics
• Search for a Task

Why can't I see announcements on my home page?  
That's because your administrator has either disabled announcements or not created any announcements.

Related Topics
• How do I create, edit, or delete announcements in Fusion Applications?

• How do I define the display settings of the home page with News feed layout?

Why can't I see the map for contextual addresses?  
That's because of either of these reasons.

• Probably you have enabled the pop-up blocker for your browser, and so you can't see the map when you click
the contextual address icon. The contextual address is marked with an orange triangle, the More icon. When
you hover over the triangle, an icon appears, which you can click to display the address on a map. To resolve
this issue, disable the pop-up blocker in your browser settings and try again.

This figure shows a work address with the contextual address icon.

• Your administrator hasn't yet set up the mapping service for contextual addresses.

Related Topics
• Set Up the Mapping Service for Contextual Addresses
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2  Search

Overview of Search  
You can use global search and page level search functionality to find specific information across the application.

• Global Search: use the search in the global header to quickly find something based on keywords across many
business objects or categories. You can also use global search, if you don't have more specific criteria to search.
When enabled, the global search is available no matter which page you're on.

• Page Level Search: use the searches on the pages where you do your work to find specific objects by entering
multiple, detailed criteria. Some pages also have keyword searches that let you quickly search for the same
business object.

You can save any search you do on a page as a new saved search and can manage the saved searches available
to you. Use filters to narrow down the list displayed in your work area, focus your search, and explore your data.
You can use the Show Filters option to view the predefined filters for the saved search you selected.

Global Search  

Examples of Using Wildcards and Quotation Marks in Global
Search  
The following scenarios provide examples of using wildcards or quotation marks in global search. Actual search results
may vary, depending on factors such as how the search is set up or what data is available.

For example, if you enter account ID as the search term, you should get all records with both words. But if there are no
results with both words, then you get records with only one of the words.

Note:  The global search isn’t case sensitive, and it ignores characters that aren't in the indexed language.

Using Quotation Marks
Enter multiple words with quotation marks to get records that have the exact phrase. For example, if you search for
"currency code", then only records with the exact phrase currency code are included in the search results.

Using Wildcards
Use the asterisk (*) wildcard to get records that replace the wildcard with zero or more characters. Use the question
mark (?) to replace the wildcard with exactly one character.

• Enter the wildcard in the middle or at the end of a search term.

• To include * or ? in your search results, precede the symbol with a backslash (\) when you enter the search
term. The symbol won't act as a wildcard, but as any other character in your search term.
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This table shows some wildcard examples.

Search Term Matches

add*
 

• The word add

• Words beginning with add, such as address

country c*
 

Phrases such as country code or country club
 

exception \*
 

The phrase exception *
 

Related Topics
• Why isn't the global search providing the results that I expect?

• How can I select the categories to search on in the global search?

• How can I select the groups to include in the autosuggest for the global search?

• How can I create a saved search for the global search?

FAQs for Global Search  

How can I select the categories to search on in the global search?  
If personalization is available for the global search (based on setup), follow these steps.

1. Click in the search field.
2. Click the Personalize icon in the autosuggest.
3. In the Search Categories tab, select the categories to search on.
4. Click OK.

How can I select the groups to include in the autosuggest for the global search?  
If personalization is available for the global search (based on setup), follow these steps.

1. Click in the search field.
2. Click the Personalize icon in the autosuggest.
3. In the Autosuggest Groups tab, select what you want to see in the autosuggest, and set the order that the

groups appear in.
4. Click OK.

Why isn't the global search providing the results that I expect?  
Results are based on indexes that are refreshed on a regular basis. Until the next refresh, you might not find recently
created records, or attribute values might be outdated.

The business object you're looking might not be included in the search.

• Personalize the global search (if enabled) and make sure the search category is selected.
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• If you don't see a corresponding search category to select, then the business object isn't set up for the
global search. Instead, use the search in the work area for that object, especially if you want to see the latest
information in the search results.

If you ran a saved search, you're likely to get results that are different from when you created the saved search. The
results themselves aren't saved, so records could have been added, edited, or deleted in the meantime.

Finally, make sure that you're correctly using symbols (for example wildcards) in search terms.

Related Topics
• Examples of Using Wildcards and Quotation Marks in Global Search

• How can I select the categories to search on in the global search?

How can I create a saved search for the global search?  
To save search terms and filters for later use in the global search (if available based on setup), follow these steps.

1. Run the search with the search terms that you want to save.
2. In the search results, click the Show Filters button if the filters are hidden.
3. Set any filters you want to save.
4. Click the Save button.
5. Name your saved search.
6. Close the Edit Saved Searches dialog box.

How can I change the criteria in saved searches for the global search?  
To change the criteria in saved searches for the global search, follow these steps.

1. Run the existing saved search.
2. In the search results, click the Show Filters button if the filters are hidden.
3. Update keywords or filters.
4. Click the Save button.
5. Leave the name as is to overwrite the existing saved search.
6. Close the Edit Saved Searches dialog box.

How can I rename or delete saved searches for the global search?  
To rename or delete saved searches for the global search, follow these steps.

1. Click the Show Filters button if the filters are hidden.
2. Click the Save button.
3. Select your saved search.
4. Rename the search or click Delete.
5. Close the Edit Saved Searches dialog box.

17



Oracle Fusion Cloud Applications
Using Common Features

Chapter 2
Search

Page-Level Search  

Examples of Using Wildcards and Quotation Marks for Searches
on the Page  
The following scenarios provide examples of using wildcards and quotation marks in search fields on the page. Actual
search results may vary, depending on factors such as how the search is set up or what data is available.

Note:  In most cases, the search field isn't case sensitive.

Using Quotation Marks
In searches with a single field for search terms, enter multiple words with quotation marks to get records that have the
exact phrase. For example, if you search for "currency code", then only records with the exact phrase currency code
are included in the search results.

Using Wildcards
Use the percent (%) wildcard to get records that replace the wildcard with zero or more characters. Use the underscore
(_) to replace the wildcard with exactly one character.

• Enter % or _ at the beginning (only in search fields that are conditionally required or not required), middle, or
end of a word.

CAUTION:  Using a wildcard at the beginning of a word can affect performance.

• You can use the wildcard more than once in one word.

• If the search criterion has an operator, you must select Starts with or Contains for the wildcard to work.

• To include % or _ in your search results, precede the symbol with a backslash (\) when you enter the search
term. The symbol won't act as a wildcard, but as any other character in your search term.

If you're using an operator other than Starts with or Contains, then you don't need to precede % or _ with \,
for the same effect.

This table shows some wildcard examples.

Search Term Matches

add%
 

• The word add

• Words beginning with add, such as address

exp_nse
 

Words such as expense or expanse
 

e_p%
 

Words such as especially or experience
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Search Term Matches

amount \%
 

The phrase amount %
 

In some cases, the _ wildcard might not match spaces or symbols that separate words. For example, currency_code
might not match currency code or currency/code.

Searches with Multiple Criteria  

Save Searches with Multiple Criteria  
On many pages, you can run a search with multiple search criteria to find specific business objects. Some of these
searches have a Saved Search list, as well as a Save button after the search criteria.

A saved search captures search criteria and other settings so that you can easily run the same search again later. Aside
from using any predefined saved searches, you can create and edit them for your own use. If you have the appropriate
roles, you can also create and edit saved searches for other users using Page Composer.

Create Saved Searches
Follow these steps:

1. Go to a search that has a Save button.
2. Optionally add or reorder fields, if available.
3. Enter your search criteria values, and, click the Save button.
4. Name your saved search and define its settings:

◦ Set as Default: The saved search is automatically selected whenever you open this page.

◦ Run Automatically (if available): The saved search runs on this page as soon as you select it from the
list of saved searches.

If you select both options, then the saved search automatically runs whenever you open this page.
5. Close the dialog box.

Your saved search can be limited to the current page, or in some cases available in other searches for the same object.

Change the Search Criteria in Saved Searches
Follow these steps:

1. Select the saved search if it's not selected already.
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2. Set your search criteria, including any additional fields.
3. Click the Save button.
4. If the saved search is one that you created, save without changing the name.

If it's predefined, then you can't overwrite it, so you create a new saved search with a unique name.

Change Settings or Rename and Delete Saved Searches
Follow these steps:

1. Go to a search that has a Save button.
2. Select Personalize from the Saved Search list.
3. In the Personalize Saved Searches dialog box, select a saved search.
4. Change any of the settings, where available.

◦ Set as Default: The saved search is automatically selected whenever you open this page.

◦ Run Automatically: The saved search runs on this page as soon as you select it from the list of saved
searches.

◦ Show in Search List: The saved search is available for you to select and run on this page.

- You can still find hidden saved searches in the Personalize Saved Searches dialog box.
- You can't change this setting if the saved search is currently selected on your page.

Note:  Some settings can't be changed for predefined saved searches. What you do change applies only to
you, unless you're editing the saved search within Page Composer.

5. If you selected a saved search that you created, then you can rename or delete it. You can't do so for predefined
saved searches.

6. Save your changes and close the dialog box.

Related Topics
• Create Watchlist Items

• What gets saved when I create a saved search for searches with multiple criteria?

What gets saved when I create a saved search for searches with multiple criteria?  
The saved search includes the following items.

• Visible search fields

• Operator and value for each field

• Search mode, either basic or advanced

• Query By Example filters, in some cases

You don't save the current set of search results or the search result sort order.

Keyword Searches with Filters  

Use Filters with Keyword Searches  
One type of search you might find on the page is a keyword search with filters.
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The single search field takes your search terms and matches against one or more attributes of a business object. After
you run the search, you can use filters to narrow down results.

Running Searches and Applying Filters
Follow these steps:

1. In the search field, enter search terms and click Search, or select an item from the autosuggest.
2. Click the Show Filters link if filters are currently hidden.
3. Optionally organize filters as follows, depending on what's available to you:

◦ Use the Add or Reorder buttons.

Note:  Avoid adding a filter that's already displayed, unless you're sure that your filter values can work
together to produce search results.

◦ Click the Personalize icon to show, hide, or reorder filters, and click OK.

4. Apply filters as follows, depending on which type of filters is available:

◦ Set filter values, and click the Search button.

◦ Select a filter or set a filter value to automatically refresh results accordingly, and use additional filters to
narrow down results further.

Related Topics
• Save Keyword Searches with Filters

Save Keyword Searches with Filters  
One type of search you might find on the page is a keyword search with filters. Some of these searches have predefined
saved searches, and you can also create and edit saved searches for your own use.

A saved search captures entered search terms, filters, and other settings so that you can easily run the same search
again later. If you have the appropriate roles, you can also create and edit saved searches for other users using Page
Composer.

Create and Edit Saved Searches
Follow these steps:

1. Enter search terms in the search field, and click Search, or select a saved search in the autosuggest.
2. Click the Show Filters link if filters are currently hidden.
3. Optionally organize filters as follows, depending on what's available to you:

◦ Use the Add or Reorder buttons.

◦ Click the Personalize icon to show, hide, or reorder filters, and click OK.

4. Set filter values or select filters, and click the Save button.
5. Name your saved search.

◦ To create a saved search, enter a new, unique name.
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◦ To update an existing saved search that you created, save with the original name.

You can't overwrite predefined saved searches by using their names, but you can create a copy with a unique
name.

6. Click Set as Default if you want the saved search to be automatically selected whenever you open this page.
7. Click OK.

Your saved search can be limited to the current page, or in some cases available in other searches for the same object.

Change Settings or Rename and Delete Saved Searches
Follow these steps:

1. Click the Show Filters link if filters are currently hidden.
2. Select Manage from the Saved Search list.
3. Define settings for any saved search, predefined or user-defined, in the Manage Saved Searches dialog box:

◦ Default: The saved search is automatically selected whenever you open this page.

◦ Show in Saved Search List: The saved search is available for you to select and run on this page. You can
still find hidden saved searches in the Manage Saved Searches dialog box.

Note:  Changes you make to predefined saved searches apply only to you, unless you're editing the saved
search within Page Composer.

4. The Active setting identifies the saved search that's currently selected on the page. You can designate a
different active saved search to have that saved search automatically selected as soon as you click OK in this
dialog box.

5. For user-defined saved searches only, you can also rename or delete the saved search.
6. Click OK.

Related Topics
• Use Filters with Keyword Searches
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3  Watchlist

Overview of Watchlist  
Use the Watchlist to track important business objects and open the pages, where you work on specific items.

In the Watchlist, you can see how many items you've, and they're arranged in specific categories. For example, in the
Expenses category, one Watchlist item is the Reports awaiting submission link. You can click the link to open the
Expenses work area, and edit and submit the expense reports. To open your Watchlist, you can click the Watchlist icon
in the global header.

Note:  The Watchlist icon isn't available for certain product families.

Aside from using predefined Watchlist items, you can create your own items, based on saved searches. You can use the
Watchlist page in the Set Preferences work area (Navigator  > Tools  > Set Preferences) to determine which categories
and items to show or hide in your Watchlist.

Related Topics
• Create Watchlist Items

• Set Watchlist Preferences

• Why are some items not displayed in my Watchlist?

• Why is the count different between a Watchlist item and the page that the item link takes me to?

• Why can't I see icons in the global header?

Create Watchlist Items  
Some saved searches are available for you to use as Watchlist items.

Open a page that has saved searches and the Manage Watchlist button enabled. All saved searches from this page that
you designate as Watchlist items would appear within one predefined Watchlist category.

Use Saved Searches as Watchlist Items
Follow these steps:

1. Create a saved search or decide which existing one to use as a Watchlist item.
2. Click Manage Watchlist.
3. Select the saved search you just created or any other that you want to use as a Watchlist item.

Remove Saved Searches from the Watchlist
To remove a Watchlist item based on a saved search, deselect it in the Manage Watchlist dialog box.
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If you deleted the saved search first, then also deselect it from the Manage Watchlist dialog box. Otherwise, it remains in
the Manage Watchlist dialog box and your Watchlist until the next refresh.

Related Topics
• Set Watchlist Preferences

• Why are some items not displayed in my Watchlist?

• Save Searches with Multiple Criteria

FAQs for Watchlist  

How can I rename Watchlist items?  
If the item is your saved search, then rename the saved search itself. The Watchlist item name gets updated the next
time that the Watchlist refreshes.

You can't rename predefined Watchlist items yourself. You can ask your administrator to do so, but the changes apply to
all users.

Related Topics
• Save Searches with Multiple Criteria

Why is the count different between a Watchlist item and the page
that the item link takes me to?  
Watchlist item counts are refreshed periodically. Relevant records could have been created, edited, or deleted since the
last refresh.
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4  Notifications and Approval Workflows

Overview of Notifications and Approval Workflows  
Workflow involves passing a task from one user to another, usually for approvals. You get in-app and email notifications,
for example, when a workflow task is assigned to you for approval. After all assignees approve, whatever got approved
takes effect.

Some tasks are just for your information (FYI), and assignees don't need to do anything. Also, you might get
notifications for things that are not part of a workflow.

Where You Get Notifications
Whether for workflow or not, here are the ways you can get notifications:

• E-mail notifications

• Notifications list in the global header

• Things to Finish section on your home page

Where You Find Workflow Tasks
You can open workflow tasks from notifications, or use your worklist or Approvals work area to find all the tasks relevant
to you. So other than notifications, here's where you can find your tasks:

• Worklist: Notifications and Approvals work area (Navigator > Tools > Worklist)

• Approvals work area (Navigator > Tools > Approvals), if your administrator has set up the work area to replace
the Worklist: Notifications and Approvals work area

• Worklist: Notifications and Approvals region on My Dashboard, if your administrator has added the region to
the dashboard

Workflow Examples
Let's take a look at examples of how you might interact with workflow tasks:

• Say you submit a transaction for approval, which creates a workflow task that gets routed to your approvers. An
approver sends the task back to you for more information about your transaction, so you provide the requested
information and send the task back. When the transaction is ultimately approved or rejected, you simply get a
notification that requires no action from you.

• If you're a manager and your employee submits a transaction that requires approval up the management chain,
you would approve or reject the transaction. Other options might be available. For example, you can delegate
the task so that someone else does the approval for you.
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Related Topics
• Actions and Statuses for Workflow Tasks

• View and Act On Notifications

• Use Your Worklist to Manage Workflow Tasks

• Define Vacation and Other Rules for Workflow Tasks Assigned to Me

• How do I remove notifications from the global header and home page?

Actions and Statuses for Workflow Tasks  
The status, or state, of a workflow task tells you where it's at in the approval process. When you're assigned to a task,
what you can do with it depends on many factors, including what the task is and its current state.

Statuses
This table describes some possible statuses, or states, for workflow tasks.

State Description

Assigned
 

Task is assigned to you and awaiting your action.
 

Completed
 

Final user in the workflow has addressed the task.
 

Errored
 

Task is in error and can't be recovered.
 

Expired
 

Current assignee hasn't addressed the task within any defined renewal period.
 

Information Requested
 

Assignee requests more information from any user.
 

Suspended
 

Task is put on hold by the task creator and not assigned to anyone to address.
 

Withdrawn
 

Task creator removes task from the workflow.
 

Actions
This table describes some possible actions you can take on workflow tasks.

Action Description

Ad Hoc Route
 

Add approvers to the task.
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Action Description

Approve
 

Approve the task, and the task completes or moves on to the next approver.
 

Claim
 

Assign the task to yourself so that you can act on it, if the task is currently assigned to a set of users.
For example, a defined group of approvers or everyone who has a certain role.
 

Create Subtask
 

Create a child task to be completed as part of the original task.
 

Delegate
 

Pass the task to someone else to take action for you, but the task is still assigned to you. Choose the
Users option and select a specific user, not the Groups option for selecting an LDAP group.
 

Dismiss
 

Close the task and acknowledge that you received it. You don't need to take action because the
notification is only for your information.
 

Escalate
 

Reassign the task to your direct manager.
 

Push Back
 

Reassign the task to the previous approver.
 

Reassign
 

Reassign the task to someone you select. Choose the Users option and select a specific user, not the
Groups option for selecting an LDAP group.
 

Reject
 

Reject the task and send it back to its creator in a final state.
 

Release
 

Make the task that you claimed available for someone else to claim.
 

Renew
 

Give yourself more time (seven days is the default) to act on the task, if the task is about to expire.
 

Request Information
 

Ask the task creator or any of the previous approvers for more information.
 

Resume
 

Revive a suspended task and continue working on it.
 

Skip Current Assignment
 

Reassign the task to the next approver (available only if you have a job role with either BPM Workflow
All Domains Administrator Role or BPM Workflow System Admin Role assigned).
 

Submit Information
 

Send the information that was requested of you regarding the task.
 

Suspend
 

Put the task on hold until it's resumed. In the meantime, no one is assigned to act on it.
 

Withdraw
 

Remove the task from the workflow (available only if you created the task).
 

Related Topics
• Use Your Worklist to Manage Workflow Tasks
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View and Act On Notifications  
Notifications alert you that something requires your attention or action. Click the Notifications icon in the global
header to open your notifications list. The number on the icon indicates how many pending notifications you haven't
acted on or dismissed yet.

Most notifications are for workflow tasks, but not all. So it's possible that what you see in the list isn't the same as what
you see assigned to you in the Worklist: Notifications and Approvals work area. Also, for one task you see in that work
area, you might get more than one notification. For example, one notification that someone requests information from
you about the task, and later another notification that the task is approved.

Here's an example of the notifications list in the global header. The Notifications icon says there are 25 pending
notifications. The first two are new ones you have never seen before and require some action on your end. The third
one you can approve or reject without even opening the notification. The next two are just FYI.

On your home page, you can also find notifications in the Things to Finish section, which looks like this.
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The first card in the Things to Finish section has two numbers:

• Assigned to Me: The number of notifications assigned to you either to act on or just FYI, in this case 10. The
rest of the cards in the Things to Finish section are the notifications assigned to you, the exact same as the
pending notifications you see in the global header.

• Created by Me: The number of workflow tasks you submitted that are still pending final approval, in this case 2.

Here are some things to know about both the Things to Finish section and the notifications list in the global header:

• From either place, you can open the Notifications page. That's where you can view and manage all your
notifications in one place, not just the ones that are pending and assigned to you.

• Updates you make to workflow tasks in the global header, for example approving them, are automatically
reflected in the Things to Finish section. Same goes the other way around, too. But changes you make
elsewhere and changes that someone else makes aren't reflected in either place until the Synchronize
Notifications in Global Header process runs, for example every two hours. The scheduled process updates
workflow notifications with the latest task status and removes notifications older than 30 days no matter
the status. For example, you approved one task from email, and someone else in the approval group that
you're part of rejected another task from their notifications list. After synchronization, the notifications asking
approval for these two tasks are removed from your list in the global header and your Things to Finish section.
Because these tasks are no longer pending for you, based on the latest task status.

• Your notifications are in the default language you've set at the time of notification creation, not the language
you selected when you signed in. If you change your default language, notifications created before the change,
for example the title or Approve and Reject buttons, remain in the language that was set when they were
created. Notifications for new tasks are in the new default language after a minimum of 30 minutes.
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How You Address Your Notifications
To view and act on notifications in the Things to Finish section, the global header, or the Notifications page:

1. Click the Notifications icon in the global header, or go to the Things to Finish section on the home page.

◦ Here are a couple of things to know about the list that opens up in the global header:

- The New icon (a blue dot) identifies any new notifications. Even if you close the list now without
doing anything else, the same notifications are no longer new the next time you open the list.

- You can search based on the text of the notification titles in the list. For example, if you search by
the term reports, search results include all notifications with reports in the title, but not the ones
without report.

◦ In the Things to Finish section, you can click the Close icon just to remove the card. The notification is
still assigned to you, so you can still find it, for example, in the global header or the Assigned to Me tab
on the Notifications page.

2. Go on to the next step, or click one of these links to open the Notifications page:

◦ Show All from the notifications list in the global header

◦ A number on the first Things to Finish card to open the corresponding tab on the Notifications page,
Assigned to Me or Created by Me

◦ Show More in the Things to Finish section

3. For a notification that requires action, you have a few options:

◦ Click the Approve or Reject button, where available.

◦ Open the Actions menu and select an action, where available.

◦ Click the notification title to see the details and select from all available actions. Depending on what the
notification is about, some actions might not apply. For workflow tasks, you get the same task details that
you do from your worklist, using the Worklist: Notifications and Approvals work area or region.

4. For a notification that doesn't require action, you also have a few options:

◦ Click the Dismiss button to acknowledge the notification and dismiss it. This option is available only for
FYI tasks. The FYI task itself isn't marked as acknowledged, so it's still pending to be either manually or
automatically completed.

◦ On the Assigned to Me tab on the Notifications page, click the Dismiss All button.

- For workflow tasks, this option is available only for tasks where action is already taken and there's
no more action pending with assignees. For example, the task is approved or withdrawn. This
option doesn't apply to FYI workflow tasks.

- If you still see some notifications after you click Dismiss All, those are notifications for FYI
workflow tasks, notifications that still require action, or notifications that you have to first open up
to see details before dismissing.

◦ Click the notification title to open the details.

◦ Just read the notification title, if the title is text-only and not a link because there aren't any details to
display.

5. On the Created by Me tab on the Notifications page, you can see the workflow tasks you submitted that are
pending final approval or already completed. Where available, you can take action on the pending items, for
example to withdraw your request.
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No matter which option you choose to address notifications that require action or not, the notification is taken off the
list in the global header and is no longer assigned to you in the Things to Finish section or the Notifications page. You
can still find the notification on the All tab on the Notifications page.

Related Topics
• Use Your Worklist to Manage Workflow Tasks

• Actions and Statuses for Workflow Tasks

• How do I remove notifications from the global header and home page?

• Why are workflow notifications that I acted on still in the global header and home page?

• Set Language Preferences

• How do I sync in-app notifications for all users in Fusion Applications?

Use Your Worklist to Manage Workflow Tasks  
Notifications are helpful for recent activities with workflow tasks, but to manage all your tasks, use your worklist instead.
With your worklist, you can, for example, keep track of tasks that you created, or browse for tasks by status.

To get to your worklist, open the Worklist: Notifications and Approvals work area. You can also find your worklist on My
Dashboard, if your administrator has added the Worklist: Notifications and Approvals region to that dashboard. There,
you get a quick view of all the tasks that are currently assigned to you based on applied filters.

Note:  If the Approvals work area is enabled by your administrator, it replaces the Worklist: Notifications and
Approvals work area.

Use the Worklist: Notifications and Approvals Work Area
Let's look at some parts of this work area.

Callout Number UI Element What You Use It For

1
 

Current Selected View menu
 

To see a certain set of tasks, for example the
tasks you created.
 

2
 

Actions menu
 

To perform an action on the tasks you select in
the table.
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Callout Number UI Element What You Use It For

 

3
 

Title column
 

To open the task details by clicking the task
title.
 

4
 

Status list
 

To filter the tasks you see in the table based on
the task status you select.
 

5 Show Tasks by Created Date list To filter the tasks you see in the table based
on created date. This filter applies only to the
default My Tasks view.

Here's how you use this work area to manage workflow tasks:

1. Click Navigator > Tools > Worklist.
2. To see only the tasks that you created, click the Current Selected View menu and select Initiated Tasks.

Or, just leave the default My Tasks view to see tasks assigned to you now or in the past, or select any other
available view.

Tip:  The default created date filter is Last 7 Days, so it's possible you may not see all of the tasks you need to
view or work on. If the table is empty, shows less activity than you'd expect, or doesn't include older tasks that
you want to work on, try selecting a longer period from the Show Tasks by Created Date list. Similarly, you
might not have any tasks with the Assigned status, which is the default status filter. To view additional tasks,
select Any from the Status list.  Remember, the Show Tasks by Created Date list is available only in the My
Tasks view.

3. To act on a task without viewing the task details, select the row and use the Actions menu on the table toolbar.
Or, click the task title to see the task details.

4. In the task details, you might also be able to do some things that don't affect the routing or status of the task.
Those actions include adding comments, adding attachments, and viewing the approval history. If you don't
see sections for those actions, use the equivalent options from the Actions menu in the task details.

◦ Add Comments: Enter comments that anyone with access to the task can see.

◦ Add Attachment: Attach files that anyone with access to the task can see.

◦ View Approvals: See the approval history for the task. For example, for a task that you created, you can
see who already acted on your request, whose approval you still need, and what the status is with each
assignee.

If you see both a table and a flowchart, you're looking at two views of the same history, with past
assignees listed in sequential order. To add more assignees to the task:

i. In the History table, select a future assignee who hasn't yet acted on the task.
ii. On the table toolbar, click the Add icon to insert an assignee before or after the one you selected.

If you're the last assignee, you can't add assignees using this Add icon. So you might try instead the Ad
Hoc Route or Reassign options from the Actions menu in the task details, if available.

5. In the task details, use the buttons or Actions menu for tasks that you need to act on. Here are some possible
options in the Actions menu:

◦ Request Information: Select the person you want information from, and enter what you're asking for
in the Comments field. Indicate what should happen after the person you selected has provided the
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information you asked for. Either the task should come directly back to you, or it should continue through
the usual workflow process.

◦ Reassign: Select whom to pass the task on to. Indicate if you're reassigning the task or just delegating it
for someone to act on your behalf.

6. For more things you can do with your worklist, click View on the table toolbar in the Worklist: Notifications and
Approvals work area. Select Servers and click the Worklist link

Use the Worklist: Notifications and Approvals Region
You get this region only if your administrator has added it to My Dashboard.

1. Click Navigator > Others > My Dashboard.
2. Use the Worklist: Notifications and Approvals region the same way you would use the Worklist: Notifications

and Approvals work area, except here you can see only tasks with the Assigned status.

Related Topics
• Actions and Statuses for Workflow Tasks

• View and Act On Notifications

• Define Vacation and Other Rules for Workflow Tasks Assigned to Me

• Use the Approvals Work Area to Manage Approvals

• Overview of Notifications and Approval Workflows

Use the Approvals Work Area to Manage Approvals  
If it’s set up, use the Approvals work area instead of the Worklist: Approvals and Notifications work area. The Approvals
work area provides an enhanced user interface and adaptive search functionality, consisting of three views allowing you
to easily find approval tasks you need to work or act on.

If the application is set up, you can click Navigator > Tools > Approvals to open it, instead of Navigator > Tools > Worklist
to open the Worklist: Approvals and Notifications work area. If it’s not set up, continue using the Worklist: Approvals and
Notifications work area.

The Approvals work area has three views.

Approvals Tasks
The Approvals Tasks page shows a list of all assigned approval tasks for which an action is needed. The list includes
approval requests, requests for information, or FYIs, which can be dismissed once acknowledged. You can organize your
work using supplied filters, search on keywords, and approve or reject approvals.
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Supplied filters include:

• Task type, for example Approvals, FYI, or Request

Note:  In the list, FYI tasks aren't included in the default filtering. If you want to see FYI tasks, select them in
the filter.

• Approval type, for example, expense reports

• From, or the person who sent the approval

You can also search by keywords on other attributes of the tasks. Any combination of search and filters can be
bookmarked and shared.

Supported actions include:

• Claim

• Approve

• Reject

• Withdraw

• Reassign

• Dismiss (FYIs)
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You can select one or more tasks and perform batch actions on them, including any action that's available for all
selected tasks. In the following cases, a drawer opens if needed to support a requirement for an action. The following
actions have drawers when performing batch actions:

• Approve and Reject and custom actions: Enter a comment if required by one or more of the selected tasks.

• Reassign: Enter the user to reassign to and a comment.

• Withdraw: Optionally, enter a comment.

You can also comment on approval or rejection actions in a drawer.

Details View
Click a task in the list to open the Details view, which displays additional information about the approval and you to
approve or reject it. You can click the Next button to navigate to the next task in the list.

To get more information or take an action that’s not in the Details view, click View More Details.

Click the Approvals Tasks link to navigate back to the list.

Approvals Status and History
Click Approvals Status and History in the Approvals Tasks page to view the current status and assignee for approvals
that you submit or have an interest in.

• Approvals you submitted

• Task statuses for approvals you’ve previously approved

• Approvals that have been rejected

• Approvals with requests for information

Use the supplied filters and search by keyword to find historic approval information.

Define Vacation and Other Rules for Workflow Tasks
Assigned to Me  
Define a vacation rule so that when you're out, tasks that are assigned to you get reassigned or delegated to someone
else. You can also have rules for other reasons, for example, to always delegate a certain type of approval.
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Enable and Define the Vacation Rule

1. In the global header, click the Notifications icon.
2. Click Show All.
3. On the Notifications page, click the Worklist button.
4. In the new browser window, click your user name and select Preferences.
5. On the My Rules tab, select the Vacation Period rule if it isn't already displayed.
6. On the Vacation Period page, select the Enable vacation period check box, and enter the start and end date for

your time out of office.
7. Select to reassign or delegate your tasks, and provide an assignee. Delegate means someone else is addressing

the task on your behalf, so the task is still assigned to you. Reassign means the task is passed on completely to
someone else.

8. Save your work.

If you need additional vacation rules, you can use the following steps to define other rules on the My Rules page. Select
the Use as a vacation rule check box on the My Rule page. Those additional vacation rules apply to the same date
range that you defined on the Vacation Period page.

For example, on the Vacation Period page you choose to delegate tasks to your administrative assistant. You also define
a rule on the My Rule page so that tasks related to hiring are reassigned to your manager. The rules under My Rules
take precedence. So, during your vacation, all of your approval tasks are delegated to your assistant except for the hiring
ones, which are reassigned to your manager.
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Define Other Rules

1. In the global header, click the Notifications icon.
2. Click Show All.
3. On the Notifications page, click the Worklist button.
4. In the new browser window, click your user name and select Preferences.
5. On the My Rules tab, select My Rules in the Rules pane.
6. Click the Add New Rule icon in the Rules toolbar.
7. On the My Rule page, enter a unique name for your rule.
8. Set dates for when the rule is effective, if needed.
9. For the rule to apply without tasks having to meet any conditions, select All Tasks from the Tasks list.

Otherwise, define or delete the condition for task type. Click the Add condition icon to define more conditions.
You can have more than one condition.

10. In the Action section, define what happens with this rule.

◦ Reassign to: Pass the task on to someone else.

◦ Delegate to: Have someone else address the task on your behalf. The task is still assigned to you.

◦ Take no action: Use this option only when you’re creating exception rules. For example, let’s say you
have a rule that reassigns all of your expense report approvals. But, you want to approve expenses from
a specific employee yourself because you had issues with their expenses in the past. You can create an
exception rule with that employee as the condition, and select Take no action. The expense reports from
that employee would remain assigned to you.

11. Save your work.
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Tip:  If you have more than one rule under My Rules in the Rules pane, you can prioritize them. Select a rule in the
Rules pane and click the Decrease Rule Priority or Increase Rule Priority icon in the Rules toolbar. Rules with a
higher priority take precedence over those with lower priority.

Related Topics
• Actions and Statuses for Workflow Tasks

• Overview of Notifications and Approval Workflows

FAQs for Notifications and Approvals  

Why are workflow notifications that I acted on still in the global
header and home page?  
If you acted on the workflow task elsewhere, the notifications remain until after the next scheduled run of the
Synchronize Notifications in Global Header process.

For example, you approved a task through email or the Worklist: Notifications and Approvals work area. The
notifications list in the global header and the Things to Finish section on the home page won't immediately reflect that
change to the workflow task. The same goes for the Notifications page that you can open from the notifications list in
the global header or from the Things to Finish section.

Related Topics
• How do I sync in-app notifications for all users in Fusion Applications?

Why can't I see a workflow notification in the global header and
home page when I can see it elsewhere?  
There are many possible reasons, depending on what your specific scenario is.

• Let's say you get an email notification but don't see it in the notifications list in the global header and the
Things to Finish section on the home page. Most likely your administrator has enabled only email notifications,
not in-app notifications. In which case, you can still find the corresponding workflow task in the Worklist:
Notifications and Approvals work area.

• Or, say you don't get a notification in email, the global header, and home page, but can see the task in
the Worklist: Notifications and Approvals work area. It's possible your administrator disabled all workflow
notifications. Or, if the user ID you use to sign in with has a space in it, that would cause issues with sending
notifications. Ask your security administrator to update your user account and remove any spaces in your user
ID.

• It's also possible that you did see the notification in the global header, the home page, or Notifications page,
but you can't find it there anymore even though you didn't address it yet. And, you might still see the task in the
Worklist: Notifications and Approvals work area. Most likely that means your notification is older than 30 days

38

https://www.oracle.com/pls/topic/lookup?ctx=fa26c&id=s20060664


Oracle Fusion Cloud Applications
Using Common Features

Chapter 4
Notifications and Approval Workflows

and was removed. Or, maybe the notification is for a task that's assigned to an approval group that you're part
of, and someone else acted on the task so it's no longer pending for you.

How do I remove notifications from the global header and home
page?  
Submit the Synchronize Notifications in Global Header process to run on a schedule, for example every two hours.
The process removes notifications older than 30 days from these places:

• The notifications list in the global header

• The Things to Finish section on the home page

• The Notifications page that you can open from either of the first two places

At any time, you can also manually remove notifications older than 30 days. Just click Notifications in the global header
and run a search.

If a notification is for a workflow task, it's removed no matter what the task status is. You may still be able to find the
task in the Worklist: Approvals and Notifications work area.

Related Topics
• How do I sync in-app notifications for all users in Fusion Applications?

Where do the currencies on notifications come from?  
On some email and in-app notifications, you might see amounts in both the original transaction currency and your
preferred currency. The preferred currency comes from your general preferences.

Note:  Your administrator can set general preferences for you, but you can also override that and set it for yourself.

Related Topics
• Set Your General Preferences

• Set General Preferences for All Users

Can email notifications be sent again to someone who was already
notified?  
Yes, your administrator can select Resend Email Notification from the Actions menu in the Transaction Console work
area to resend emails to the current workflow task assignee. If you have access to the work area, you can do so yourself.

For example, if a task has been pending for a while, maybe the assignee didn’t see the original email notification, or had
accidentally deleted it. Or, the original email body wasn’t formed correctly. For any of these cases, and more, resending
the email can help move the approval along.
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Related Topics
• Manage Workflow Transactions

Monitor and Troubleshoot Transactions  

Manage Workflow Transactions  
After workflow tasks are created, it's helpful to keep track of them and jump in when needed, especially when
something goes wrong. If you have the appropriate access, you can monitor and troubleshoot workflow tasks for others
and for yourself.

Use the Transaction Manager: Transactions page in the Transaction Console work area to manage transactions. A
transaction is a business process that involves a workflow task. Here are some of the things you can do:

• Track transaction statuses and download spreadsheets with information about transactions.

• Download and review diagnostic logs for transactions. For example, you can see the conditions in the approval
rules that might have caused an error.

• Depending on what's going on with the transaction and what access you have, you might be able to, for
example, reassign or recover the transaction.

Find Transactions
Follow these steps:

1. Click Navigator > Tools > Transaction Console.
2. If you see tabs, make sure you're on the Transaction Summary tab.
3. On the Transaction Manager: Transactions page, check the Last Refresh time stamp after the page title to see

when the transaction statuses were last updated. Click the Refresh icon if needed. You can refresh any time as
long as someone else didn't already start a refresh.

◦ You can also click the Refresh icon for a specific row in the table to refresh individual transactions.

◦ Also, the Refresh Transaction Administrator Console Transaction Status scheduled process
automatically runs to refresh the statuses.

◦ If you open the details for a specific transaction (step 5), its status also refreshes and you see the latest
on the details page.

4. View the transactions with a status that matches the default Status filter, for example Failed. You can remove
this filter to get results for all statuses. Or, use the search and filters to apply your own criteria, for example, to
find transactions that are priority 1 or submitted by a specific person, or to use more performant fields.

◦ You can use the search to find results based on keywords in the Name or Process Name column, or
specifically use the Name or Process Name filters. Name is the person or object the workflow task applies
to, and the process reflects the type of workflow task.

◦ You can personalize filters to add or hide filters, and create saved searches for future use. For example,
it's recommended to use the more performant Assignee Name field instead of Assigned To, and to select
the Assignee Role field to search for transactions assigned to a specified role. If the Submitted By field
is part of your saved search, you may be prompted to re-create the search to take advantage of a more
performant Submitted By field.
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5. Select and act on the transactions right there from the results table, or click the transaction in the Name
column to see details, such as diagnostic information for failed transactions, and go from there.

Act On Transactions Without Opening Details
Here's what you do:

1. Select one or more transactions from the results table.
2. Optionally use the Priority menu to set an issue priority, so that you can later filter on the priority to find these

transactions.
3. Open the Actions menu and select an action. If you selected more than one transaction, you see only the

actions that can apply to all of them.

Use Transaction Details
What you can see and do in the transaction details depends on the transaction status and what access you have. For
example, for transactions that are in progress or completed, you might see the approval history, which shows who
already approved and who the current assignee is, if any.

For failed transactions, you can get information about the issues and, if you're an administrator, usually take some
action:

1. Select an issue from the Issues list, if the transaction has more than one issue.
2. Review the information in the Instructions and Details sections, including any description and resolution for the

issue, as well as the related workflow task and approval rule.
3. Click the Download link to get the diagnostic log.
4. Use the Issue Priority list to set an issue priority, if you want to later filter on the priority to find this transaction.
5. From the Assigned To list, select the person who should fix the issue, for tracking and filtering purposes.

Note:  You can change the Assigned To field in your saved search to the more performant Assignee Name
field, and add the Assignee Role field to search for transactions assigned to a specified role.

6. Add comments, for example to track what you're doing to address the issue, or note down any service request
IDs. You and others can see these comments only in the Transaction Console, not with the workflow task in the
worklist.

7. If you can, take action to address the issue. Here are some examples of how you might go about it:

◦ Open the Actions menu and select an action to manage the transaction.

◦ Follow up with the person you assigned the issue to or your help desk. Give them the diagnostic log and
other information from the transaction details.

◦ Reconfigure the approval rule that the transaction is based on, and have the workflow task resubmitted.

8. Select another issue from the Issues list, if any, and go through the same process.
9. Click Save and Close.

Download a Spreadsheet of Transactions
This is all you need to do:

1. In the results table, select the transactions you want to include in the spreadsheet. To get all transactions, either
select all of them or none at all.

2. On the Actions menu, click Download.
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Related Topics
• Statuses for Filtering Transactions

• Automatically Refresh Transaction Statuses

• Actions for Managing Transactions

• Use Filters with Keyword Searches

• Save Keyword Searches with Filters

Statuses for Filtering Transactions  
Use the Transaction Manager: Transactions page in the Transaction Console work area to track the status of
transactions. For example, you can filter the transactions by status to see just the transactions that are in progress or
stuck.

Note:  These statuses aren't the actual workflow task statuses that you see in the worklist or in notifications.

Status Description

Auto Recovery
 

The transaction ran into some issues, but the application is trying to fix them without any action on
your end.
 

Completed
 

All approvals are done and the transaction successfully went through all processes.
 

Draft
 

The transaction is saved but not submitted yet. This status doesn't apply to all product families.
 

Failed
 

The transaction has one or more errors, for example, due to a network or database outage, or an issue
in the approval rules setup.
 

In Progress
 

At least one approval is still pending for the transaction before it's all done.
 

Stuck
 

The transaction was submitted, but ran into issues so the workflow task doesn't exist yet.
 

Submitted
 

The transaction was just created and hasn't moved on yet to another status. This status doesn't apply
to all product families.
 

Related Topics
• Manage Workflow Transactions

• Actions and Statuses for Workflow Tasks
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Automatically Refresh Transaction Statuses  
The Refresh Transaction Administrator Console Transaction Status scheduled process automatically runs every
hour. It refreshes the statuses on the Transaction Manager: Transactions page in the Transaction Console work area.

Hourly is the recommended frequency, and it should be enough, especially since you can just refresh using the Refresh
icons on the page. But if you really need to, say due to an extraordinary volume of transactions, you can submit the
process to run on a more frequent schedule.

• Be careful if you do this, because you are adding load to the queue of all scheduled processes. Consider if that
potential performance impact is really warranted.

• If your manually submitted process has any scheduled runs that overlap with the automatic hourly ones, your
process would run instead of the automatic one.

• The automatic process still runs whenever there’s no overlap with your process.

• The time it takes for the process to finish depends on the volume of transactions, but it usually ends in minutes.
So if it’s taking hours or longer, something is most likely wrong.

To run this scheduled process, you need a custom job role that has the Perform HCM Approval Transaction Actions
(PER_PERFORM_APPROVAL_TRANSACTION_ACTIONS_PRIV) privilege. If you can access transactions on the
Transaction Manager: Transactions page, you already have this privilege.

Related Topics
• Submit Scheduled Processes and Process Sets

Actions for Managing Transactions  
Use the Transaction Manager: Transactions page in the Transaction Console work area to manage and troubleshoot
transactions. There are many actions you can take. For example, you can withdraw a transaction even if you're not the
one who submitted it.

What you can do depends on the transaction status and the custom roles you have. Some actions, such as approve and
reassign, are the same as the ones you can take on the workflow tasks from the worklist or from notifications.

Action Description

Add Comment
 

Add your notes for the transaction, for example to track what you're doing to address the issue, or
to jot down any service request IDs. You and others can see these comments only in the Transaction
Console.
 

Alert Initiator on Error
 

Notify the submitter if the transaction ends up in error.
 

Approve
 

Approve the transaction if the workflow task is currently assigned to you to approve or reject.
 

Download
 

Get a spreadsheet with information about the selected transactions.
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Action Description

Reassign
 

Reassign the workflow task to an approver, the submitter, or someone else. This action isn't available if
the workflow task is based on a Position list builder.
 

Recover
 

Restart the process after the transaction stopped due to errors. After you address the issue, use this
action to pick up where the process had stopped and try what had ended up in error again.
 

Reject
 

Reject the transaction if the workflow task is currently assigned to you to approve or reject.
 

Resend Email Notification Send an email notification to the current assignee of the workflow task, for example, if they can’t find
the original email. This action is available only if the transaction is in progress and involves a workflow
task that’s currently assigned.

• In some cases, the in-app notification is sent as well.

• If someone from a group of approvers has claimed the task but hasn't acted on it, the notification
is still sent to the entire group.

Terminate Process
 

Completely end the transaction so that no one can see or act on the workflow task again.
 

Withdraw
 

Remove the workflow task from the workflow. You can ask the submitter to submit again, for example,
 after an issue is resolved.
 

Related Topics
• Manage Workflow Transactions

• Statuses for Filtering Transactions

• Actions and Statuses for Workflow Tasks

Archive and Purge Transactions  
To optimize the performance of the Transaction Manager: Transactions page in the Transaction Console work area,
archive and purge completed transactions. Run the Archive Transaction Console Completed Transactions scheduled
process to remove transactions from the page.

A transaction must meet these criteria to be eligible for archive and purge:

• The transaction has the Completed status for at least a certain amount of time. The default is three months.

If you have access to the Approval Rules tab in the Transaction Console work area, you can change the duration
for all transactions of specific business processes. Here are the options you can select:

◦ 3 months

◦ 6 months

◦ 9 months

◦ Don't archive

• All workflow tasks in the transaction are already archived and purged.
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If you have access to the Approval Rules tab, you can also click the Archive icon to run the scheduled process
immediately.

Before You Start
You need a custom job role that has the Run Approval Transactions Archive Process
(PER_RUN_APPROVAL_TRANSACTIONS_ARCHIVE_PROCESS_PRIV) privilege.

Review this before you submit the process:

• You’re strongly advised to schedule the process to run once a day, during off hours.

• Make sure that the process doesn’t try to start while another run of the same process is still going. This process
is self-incompatible and only one instance of the process can run at any given time.

• The time it takes for the process to finish depends on the volume of transactions, but it usually ends in minutes.
If you're running the process for the first time, or it hasn't run in a very long time, the process might take much
longer to finish. So it’s best to run it daily, as recommended.

Parameters
If you have access to the Approval Rules tab, most likely you don’t need to worry about these parameters. You can just
define and use the settings on that tab. But if you don’t have access, you can use these parameters to override those
settings. Another reason you might use these parameters is if you have a need to archive immediately at any given
time, for one or more business processes.

• Days: Enter the number of days that a transaction must already have the Completed status to be eligible for
archive and purge.

◦ Enter 0 if you want all transactions with the Completed status to be eligible immediately.

◦ This parameter isn’t available by default, but requires setup.

◦ This parameter applies to transactions in all business processes.

◦ If you leave this parameter blank, or the parameter isn’t available, the setting for each business process
on the Approval Rules tab takes effect. For example, the 3 months default, or Don’t archive.

• Process Name: Select all or specific business processes.

◦ The scheduled process includes transactions for the selected business process names.

◦ If you leave this parameter blank, the scheduled process considers all business processes except the
business processes set to Don’t archive on the Approval Rules tab, if any.

Let’s say you enter 30 for the Days parameter and leave the Process Name parameter blank. Business processes set to
Don’t archive on the Approval Rules tab are excluded. The 30 days would still apply to all other business processes on
the tab.

Purge Archived Transactions
You can set up purge policies to archive transactions in the Transaction Console based on your organization’s data
retention policies.

Related Topics
• Submit Scheduled Processes and Process Sets

• How Workflow Tasks Are Archived and Purged
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Review Employee Vacation and Delegation Rules  
Use the Employee Vacation and Delegation Rules Report to get details about the rules that users defined to reassign or
delegate the workflow tasks assigned to them. This report is available as a scheduled process.

For example, your employee is on vacation, and you need to know what happens to tasks assigned to them during that
time. The report tells you if they have set up a rule to reassign or delegate to someone else to approve. You can also see
who the designated person is.

Before You Start
Review this before you run the report:

• You can run the report as a scheduled process from the Scheduled Processes work area if you have a custom
role that contains the following:

◦ Run BPM Workflow Reports (FUN_RUN_BPM_WORKFLOW_REPORTS_PRIV)

◦ Run BPM Workflow Reports (FUN_RUN_BPM_WORKFLOW_REPORTS_PRIV_OBI)

• Run the report on an as needed basis, whenever you need information about users' vacation or other
delegation rules. Don't submit this report to run on a recurring schedule.

Report Parameters
The report includes rules that are active, inactive, or both on the day that you run the report. Let’s say you run the report
on November 10, and select October 1 for the From Date parameter and October 30 for the To Date parameter.

And for example, there are three rules with these active dates:

1. September 25 to October 10
2. October 5 to October 15
3. October 30 to November 30

The report can potentially include any of these rules, which have active dates within the period you set in the From Date
and To Date parameters. What you select for the Rule Status parameter determines which of the three rules are actually
included in the report:

• Active: Only the third rule is included because only that rule is still active on November 10.

• Inactive: Only the first two rules are included because those are inactive on November 10.

• All: All three rules are included.

Note:  If you leave the From Date and To Date parameters blank, the report runs as if you had entered the first and last
date of the current month.

Report Output
You don’t need to define the output when you submit the report. You will get a spreadsheet with these sections:

• Originator Employee Details: Information about the user who defined the rule.

• Rule Details: Information about the rule, including when the rule is effective and any conditions that a workflow
task must meet for the rule to apply. There are two types of rules:
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◦ Vacation: A rule for when the user is out of office.

◦ Delegation: Any other rule that the user defined for tasks assigned to them, for example to delegate or
reassign tasks based on certain conditions.

• Destination Employee Details: Information about the person whom tasks are delegated or reassigned to.

If you don't get a spreadsheet, or the spreadsheet is blank, one thing you can do is to contact your security
administrator. Confirm if you do in fact have the privileges listed earlier.

Related Topics
• Submit Scheduled Processes and Process Sets

• View Output from Scheduled Processes

How You Can Regularly Reassign Pending Approvals for Workers
That Become Inactive  
A manager assignment can become inactive due to the end of an assignment or work term, termination, or global
transfer. If the manager has any pending approval notifications, you must reassign them.

Run this process: Run Reassign Pending Approvals for Terminations and Correct Invalid Supervisor Assignments
Process in the Scheduled Processes work area. You can set a schedule to run it at least once a day. You can run it more
frequently if you want things updated faster.

Here's what the process does:

• It reassigns the direct reports of a terminated manager to that person's line manager and also assigns any
pending notifications to the line manager. Only actionable notifications will be reassigned.

• It reassigns pending approval notifications based on the number of days you specify using the Past Period in
Days Considered for Reassigning Pending Approvals parameter.

Related Topics
• Submit Scheduled Processes and Process Sets
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5  Tables

How You Use Tables  
You can find tables on many pages. Some tables are simple, while others give you several options to view and manage
the data, many of which are described here.

Some of the options may or may not be available on the particular table you're using. You can find most of the options
in the table toolbar, which usually has menus such as Actions, View, or Format.

Select Data
To select a row or column:

• Row: Click anywhere within the row. Or, hover over the small cell beside first column, and click when your
cursor becomes an arrow.

• Column: Hover over the column heading and click when your cursor becomes an arrow. In tables that allow
multiselect, you can use the Shift or Control key to select multiple rows at once.

Note:  Some items in the table menus or toolbar are disabled until you select a row or column. For example, only after
selecting a row, you can then select About This Record from the View menu, to see who created and last updated the
record, and when. The Creation Date field shows the date and time when you first start creating a record. The Last
Update Date field shows the date and time when the record is saved. So, suppose you start creating a record, enter
data, and then click Save after 35 seconds. The time displayed for Creation Date and Last Update Date will have a
difference of 35 seconds. If you make any subsequent updates to the record, your last update date will change.

View Data
Here are the various options you can use to view the data in a table.

• Use filters in the toolbar or Query By Example to narrow down the data. Query By Example is the row of fields
that precedes the column headings.

• Click Refresh in the toolbar, or select Refresh from the Actions menu. You reload the table with the latest
available data.

• Click Detach in the toolbar, or select Detach from the View menu. You can see more of the table in the
detached view.

• Select a column and click Wrap in the toolbar, or select Wrap from the View menu. You can see all the text in
each cell within the column.

• Click Export to Excel in the toolbar, or select Export to Excel from the Actions menu. You get a Microsoft Excel
file with the data in the table.
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Sort Data
To sort the data in a table:

• Hover over the column heading of the column you want to sort by, and click the Sort Ascending or Sort
Descending icon.

• Select Sort from the View menu.

Edit Data
To edit the data in a table:

• Select a row and click Edit in the toolbar to open a dialog box or another page.

• Click a link in the row to open a dialog box or another page.

• Click a row to make that row editable within the table.

Manage Columns
You can determine which columns to see and how they appear using the Manage Columns option from the View
menu. But the Manage Columns option isn't available for tables with flexfields. To check whether a table on a page
contains flexfields, click your user image or name in the global header, and on the Settings and Actions menu, select
Highlight Flexfields. If you don't have administrative privileges, you may not find the Highlight Flexfields option.

• Hide or show: Select Columns from the View menu.

• Resize: Hover between column headings and move the divider. Or, select the column, and then select Resize
Columns from the Format menu.

• Reorder:

◦ To move a column, click the column heading and, when your cursor becomes two double-pointed arrows,
move the column to a new position.

◦ To reorder multiple columns, select Reorder Columns from the View menu.

• Freeze: Select the column that you want to freeze, and then either click Freeze in the toolbar or select Freeze
from the View menu.

Related Topics
• Use Query By Example

• What's included in the file I get when I export a table?

• How can I locate flexfields on a page?

• Overview of Flexfields
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Query By Example  

Use Query By Example  
Query By Example is the row of fields that precedes the table column headers, used for filtering the data in the table.

Applying the Query By Example Filter
Follow these steps:

1. Click Query By Example on the table toolbar if the row of fields isn't displayed.
2. Enter filter values in any or all of the Query By Example fields.
3. Press Enter.

The table now shows only the records that meet the criteria you entered in all Query By Example fields.

Refreshing the Filtered Results
Do any of the following tasks:

• Press Enter again with your cursor in any of the Query By Example fields.

• Click Search or Refresh on the toolbar, if available.

• Select Refresh from the View menu, if available.

Note:  The filter applies even if the Query By Example fields are hidden.

Removing the Query By Example Filter
Click the Clear All icon at the beginning of the Query By Example row, if available.

If not, then follow these steps:

1. Delete what you entered in each Query By Example field.
2. Refresh the table.

To clear not just Query By Example but any other table filters:

1. Select Clear from the View menu or click Clear on the table toolbar, if available.
2. Refresh the table.

Related Topics
• Operators and Wildcards for Query By Example
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Operators and Wildcards for Query By Example  
You can use operators and wildcards in Query By Example fields. Operators and wildcards work in alphanumeric fields
only, not date fields.

Operators
This table describes the operators that you can enter in Query By Example fields.

Operator Description

None (you enter only a value)
 

• Character field: Starts with

• Number or date field: Equals

>
 

Greater than
 

<
 

Less than
 

>=
 

Great than or equal to
 

<=
 

Less than or equal to
 

and
 

And
 

Note:
You can use this operator only in conjunction with other operators, for example: >0 and <=1000.
 

or
 

Or
 

Here are a few things to know about the >, <, >=, and <= operators:

• Results are based on alphanumeric sort, in alphanumeric fields. For example, if you enter >=ABC, then ABC,
ABD, ABCA, ACB, and BAC are matches, but not AB5 or AB.

• A space is considered part of the filter value. For example, if you enter >= ABC, then ABC and ABD are matches
only if they're preceded with a space.

Wildcards
This table describes the Query By Example wildcards that you can use at the beginning, middle, or end of your entered
value. All other symbols are ignored.
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Wildcard Description Examples

*
 

Multiple characters
 

Entered Value: add*
 
Matches: The word add and words beginning
with add, such as address
 

_
 

Single character
 

Entered Value: exp_nse
 
Matches: Words such as expense or expanse
 

Related Topics
• Use Query By Example

Export to Excel  

What's the difference between Export to Excel and desktop
integration for Excel?  
You use the Export to Excel button or menu option to download data from your table as a Microsoft Excel file. You can
then use this file to view or analyze your data.

You use desktop integration for Excel to create or edit records in Excel workbooks, and then upload them back into the
application. This comes in handy when you have to work offline or make mass updates. In most cases, you download
the desktop integrated workbook from a link in a panel tab or your table.

Related Topics
• Guidelines for Using Desktop Integrated Excel Workbooks

What's included in the file I get when I export a table?  
You get the rows you select in the table. If row selection is disabled or you don't select anything, then you get all rows,
including any that aren't visible on the page.

In any case, some data might not be included in the following scenarios.

• Any search criteria, filters, and Query By Example values apply to the table.

• The table has any hidden columns.

• You're working with a table that shows a certain number of rows per page or view. Try going to subsequent
pages or views to export.
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6  Excel Add-Ins

Oracle ADF Desktop Integration Add-In for Excel  

Set Up Desktop Integration for Excel  
You can create or edit records and upload them to the application using integrated Excel workbooks. To use these
workbooks, you must install an Excel add-in.

Note:  Every release of Oracle Fusion Cloud Applications is likely to have a new version of the Oracle ADF Desktop
Integration add-in. When prompted, install the latest version of the add-in.

• For information on the new version, see the relevant What’s New document.

• For information on the upgrade policy for the Oracle ADF Desktop Integration add-in, see: Add-In Upgrade
Policy for ADF Desktop Integration (DOC ID 2242879.1) on My Oracle Support.

Install or Upgrade the Desktop Integration Add-In
To install or upgrade the Oracle ADF Desktop Integration Add-In for Excel, you must have the appropriate Excel and
Windows version. See: Supported Platforms for ADF Desktop Integration (DOC ID 2242428.1) on My Oracle Support. Also,
make sure that you have the Download Desktop Integrator (ATK_DOWNLOAD_DESKTOP_INTEGRATOR_PRIV) privilege
to access the add-in installer.

1. Sign into your computer with your account.
2. Close Excel.
3. Click Navigator > Tools > Download Desktop Integration to download the installer file.
4. Run the adfdi-excel-addin-installer-current-user.msi installer just like you would run any program that you

install on your computer.
5. Run Excel once to complete the installation.

Note:  If you have administrator privileges, you can also install the add-in for all users. For more information, see: How
to install the ADF Desktop Integration Add-in for Excel (DOC ID 2681794.1) on My Oracle Support.

Related Topics
• Troubleshoot Desktop Integration for Excel

• Guidelines for Using Desktop Integrated Excel Workbooks

• Business User's Guide for ADF Desktop Integration

55

https://docs.oracle.com/en/cloud/saas/readiness/common.html
https://support.oracle.com/epmos/faces/DocumentDisplay?id=2242879.1
https://support.oracle.com/epmos/faces/DocumentDisplay?id=2242879.1
https://support.oracle.com/
https://support.oracle.com/epmos/faces/DocumentDisplay?id=2242428.1
https://support.oracle.com/
https://support.oracle.com/epmos/faces/DocumentDisplay?id=2681794.1
https://support.oracle.com/epmos/faces/DocumentDisplay?id=2681794.1
https://support.oracle.com/
https://docs.oracle.com/en/middleware/developer-tools/adf-desktop-integration/5.2/develop-desktop-integration/business-user-guide1.html#GUID-ED85A0BB-B4DC-45D9-9030-73C5483D8162


Oracle Fusion Cloud Applications
Using Common Features

Chapter 6
Excel Add-Ins

Guidelines for Using Desktop Integrated Excel Workbooks  
Where available, you can download a desktop-integrated Microsoft Excel workbook and use it to create or edit records.
Your edits in the workbook don't affect the application until you upload the records back into the application.

What You Must Not Do
To ensure that you successfully upload your changes to the application, avoid doing these tasks:

• Rename text from the integrated workbook, such as the worksheet names.

• Add columns.

• Delete any part of the template, such as columns.

• Hide required columns and status columns or headers.

CAUTION:  Don't close Excel using the Windows Task Manager and clicking the End task button because that might
disable the add-in.

Conventions
Some column headers in the integrated workbook might include [..]. This means that you can double-click within any
cell in the column to open a dialog box, where you can select a value to insert into that cell.

Statuses
You can use Status Viewer to see the status of the entire integrated worksheet and the status of any row in a
worksheet. To use the status viewer, click Status Viewer on the Excel ribbon. You can see the status of the entire
integrated worksheet by default. To see the status of a row, click any table row in a worksheet. You can use the
information that appears on the Status Viewer to review and correct errors at the same time.

Searches
Some integrated workbooks include searches. To search within the workbook, you must first sign into the application.
When you click the Search button, the application prompts you to sign in if you haven't already done so.

Refreshes After Upload
If your changes aren't reflected after you upload the records back into the application, you can try out these options:

• Refresh the table

• Use a filter or search on the table to see your changes

Related Topics
• Set Up Desktop Integration for Excel

• Troubleshoot Desktop Integration for Excel

• How You Use Tables
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Troubleshoot Desktop Integration for Excel  
If you run into any issues with the integration, use the Client Health Check tool first to find out what integration issues
you might have and how to resolve them.

For more information, see: How to use the ADF Desktop Integration Client Health Check Tool (Doc ID 2010222.1) on My
Oracle Support.

If the health check tool doesn't resolve your issue, you can uninstall and reinstall the Oracle ADF Desktop Integration
add-in. For more information, see: Information Center: Troubleshooting Oracle ADF Desktop Integration (DOC ID
2012600.2) on My Oracle Support.

Note:  To check the version of Oracle ADF Desktop Integration, see: ADFdi Version Check (Doc ID 2012570.1) on My
Oracle Support.

Uninstall the Desktop Add-In
Use the Microsoft Windows Settings to remove the ADF Desktop Integration add-in. After removing the add-in, you can
use the integrated Excel workbooks on this system only after you reinstall the ADF Desktop Integration add-in.

1. Open Windows Settings and go to Apps & features.
2. Select Oracle ADF Desktop Integration Add-In for Excel from the list of programs.
3. Click Uninstall from the toolbar at the top of the program list.
4. When prompted, click Uninstall to remove the Oracle ADF Desktop Integration add-in.

Note:  If you have installed the Oracle ADF Desktop Integration add-in on multiple user profiles using the current-user
installer, you must remove it from each user profile.

Related Topics
• Set Up Desktop Integration for Excel

Oracle Visual Builder Add-In for Excel  
Use Oracle Visual Builder Add-in for Excel to integrate Microsoft Excel spreadsheets with REST services to retrieve,
analyze, and edit business data from the REST service.

You can download your data to an Excel spreadsheet, work with it, and upload your changes back to the REST service.
After you install the add-in, a new ribbon tab (Oracle Visual Builder) appears in Microsoft Excel. You can use the
buttons in this ribbon tab to configure a worksheet to integrate with a REST service and download the data to a data
table that you create in the worksheet. Once you create the data table and populate it with data, you can review, modify,
and create data before uploading changes to the REST service. After you integrate the Excel worksheet with the REST
service, you can optionally publish the Excel workbook that contains the integrated worksheet.

Related Topics
• Using the Oracle Visual Builder Add-in for Excel
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7  Attachments

How can I delete attachments?  
Use the Delete icon button. Alternatively, you can use the Manage Attachments icon button to open the Attachments
dialog box and delete specific attachments.

Can I view attachments in a different format?  
Attachments, by default, appear in the table view. You can also view them in two other ways, list view and cards view, if
the options are enabled.

To switch between the different views, click the toggle buttons on the toolbar.

How can I filter attachments?  
Use the filtering options, if enabled, on the toolbar of the attachments window to display only those attachments that
are specific to your search. You can filter attachments by Type, Title, Description, Category, and so on.

If you filter the attachments by Type, you get additional options to search for a specific file, folder, text, or a URL.

What happens if I update an existing attachment?  
If an attachment of the same type and name is uploaded again for the record, the attachment gets stored as a new
version. The previous attachment remains available, displaying the time stamp to indicate how old that version is.

To view the version of an attachment for a record, click Actions > File Revision History.

By default, always the latest attachment appears for a particular record. However, if the option is enabled, you can pick
any other version of that attachment and set it to default. Anyone viewing the attachment for that record will see the
default version that you set, even if that's not the latest one.
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8  Data on Application Pages

How can I print the data in the page I am on?  
Click your user image or name in the global header, and from the Settings and Actions menu, select Print Me (if
available).

You get a view of the page, which you can then print using your browser's standard print feature. This view includes
any field, table, or other UI element on the page that has data. If the page has tabs, then only the currently open tab is
included.

If you want just the data in specific tables, you can also use the Export to Excel button or menu option on the table, if
available. You get a Microsoft Excel file containing data from the table, which you can then print.

Related Topics
• What's included in the file I get when I export a table?

Why can't I see all the values I expect in my list of values?
 
Probably your list of values (LOV) has more than 500 values. By default, any LOV displays a maximum of 500 values. So,
if you can't see your LOV in the list, you can use the Search field to find specific values.

How can I locate flexfields on a page?  
You can locate flexfields on a page using the Settings and Actions menu. Click your user image or name in the global
header to open this menu, and select Highlight Flexfields to locate flexfields on a page.

You can hover over the Basic Info icon to see details about specific flexfields. Verify that you have the appropriate roles
to view and configure the flexfields.

How can I enter or edit translated text in Fusion
Applications?  

1. For a row in a table or for a field in a form, click the icon for translations (where available).
2. Select a supported language, and view, edit, or enter the translated text.
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If the translated text is in your current session's language, you can see the translation apply to the UI immediately.

What's the difference between Language and Source
Language?  
When a text value is created, the language that it's created in is considered as the source language in the translation
editor. This value is used as the default one if no translated text is available.

When a translated text is entered, the source language value is updated to the language for that translated text. For
example, suppose you have a row with text value created in American English. If you use the translation editor to update
that row with the value for language as Spanish, the source language for that row will be updated to Spanish. So, a quick
glance at the translation editor tells you which values are translated and which aren't. For example, if the values in the
Language and Source Language fields match, that means the values are translated. While, if they don't match, that
means the values aren't translated, and you can also tell where the default value is coming from. If the default value for
a row's source language is changed, all values for the rows whose Language and Source Language fields match, will also
change.

Why does the Date field display a different value than my
preferred date?  
By default, the Date fields that don't have any associated time values show the date in the server time zone, UTC,
irrespective of your preferred time zone.

Also, if you're using the calendar date picker to set today’s date, the Date field gets populated with the current date in
the server time zone, not your preferred time zone.

How's user personalization enabled in Redwood
application pages?  

The Oracle Applications Recommendation Service (OARS) provides user-specific recommendations and personalization
across Redwood user interface components. The client library delivers these capabilities within the browser and across
sessions. At key interaction points, the persistence service synchronizes client-side data with the server to ensure a
consistent end-user experience across browsers and devices.

When supported by the applications you use, the system tracks your most frequently and recently used items to
personalize recommendations in choice lists and Ask Oracle search. Availability of these recommendations depends on
whether the application page has enabled this capability.

Here are two examples of how OARS personalizes the user experience.

• While using Ask Oracle search, you can save combinations of applied filters and subsequently reuse them.
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• While working with tabulated records, the column visibility and the column order you use are tracked, and these
personalizations are automatically applied in subsequent sessions.
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9  Scheduled Processes

What are scheduled processes?  
Scheduled processes do tasks that are too complex or time-consuming to do manually, for example importing data or
updating many records. You can run scheduled processes on a recurring schedule and send notifications based on how
the process ends.

Some scheduled processes give you printable output. Those processes might have Report in their name.

Use the Scheduled Processes work area to run all the processes you've access to and to manage submissions. If you
need access to this work area, ask your security administrator to assign you a role that gives you access, for example
a custom role with the the Manage Scheduled Processes (FND_MANAGE_SCHEDULED_PROCESSES_PRIV) privilege.
Other than the Scheduled Processes work area, you might be also able to run certain processes from other work areas.

Jobs and Job Definitions
Each scheduled process that you run is based on a job. The job is the executable that controls what the process does.
Each job needs a job definition, which, for example, identifies the parameters and other options you've set for the
process. You or your administrator can create job definitions for Oracle Analytics Publisher reports so that users can run
the reports as scheduled processes.

Process Sets
A process set is a scheduled process that contains multiple processes or even other process sets. So, when you submit a
process set, you're running more than process.

Note:  When you submit certain scheduled processes, the job logic causes other processes to automatically run. But
in this case, you're not submitting a process set that includes those other processes.

Submission
When you submit a scheduled process, you can use its parameters to control how, and which records are processed.
For example, a process includes only the transactions that were edited by the person you select for a Last Updated By
parameter. Some scheduled processes don't have parameters.

As part of the submission, you can also set up a schedule for the process, for example to run once a week for two
months. Every time a process runs, there's a unique process ID.

Output
Some scheduled processes provide output in PDF, HTML, and other formats. For example, a process can import records
and also produce output with details about those records. There are many types of output, for example a tax document
or a list of transactions.
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Process Sets  
A process set is a scheduled process that contains at least two processes. So you can run many processes in one go, for
a specific purpose.

Processes in process sets run in a certain order, in serial or parallel, or by some other logic. For example, let's say we
have a process set with three processes to do these three tasks:

• Validate and clean up records.

• Import the records.

• Give a report on the imported records.

What They Contain
Process sets can have any number of individual scheduled processes and even other process sets. Sometimes, a single
process set has multiple process sets that are nested. For example, a process set can include three processes and two
process sets, one of which contains another process set.

Related Topics
• Example of Process Details for a Process Set

• Submit Scheduled Processes and Process Sets

• What are scheduled processes?

Submit Processes  

Submit Scheduled Processes and Process Sets  

Watch video
 

Use the Scheduled Processes work area to run all the scheduled processes that you've access to, including process sets.
You can also submit many processes from other work areas.

Some processes that give you output are also reports that you can view from the Reports and Analytics work area
or panel tab. You can find that panel tab in some work areas. It's quick to submit a scheduled process with the bare
minimum steps. But there are many additional options you can set, for example, if you want to run the process on a
schedule.

Select the Scheduled Process and Define Parameters
Here's what you do:

1. Click Navigator  > Tools > Scheduled Processes.
2. On the Scheduled Processes Overview page, click Schedule New Process.
3. Leave the type as Job, select the process that you want to submit, and click OK.
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4. In the Process Details dialog box, enter at least the required parameters, if any.

◦ Some processes have no parameters at all.

◦ Some parameters depend on other parameters. For example, date range parameters might appear only
after you select By Date for another parameter.

5. Click the Advanced button if you want to define the schedule, notifications, or output. Continue to the next
steps. Or, just skip to the steps for finishing the submission, to run the process once as soon as possible with
the default output.

Define the Schedule
Set up a schedule to run the process on a recurring basis or at a specific time. Use the Process Details dialog box in
Advanced mode.

1. Open the Schedule tab and select Using a schedule for the Run option.
2. Select a frequency, for example Daily or Monthly.

◦ Select User-Defined if you want to enter the exact dates and times to run the process.

◦ You can select Use a Saved Schedule to use an existing schedule, if there are any.

3. Depending on the frequency you selected, define when the process should run.

Some processes can't be run more often than a certain frequency, for example more than every 10 minutes. But there
are some situations where that validation doesn't apply, for example, when different users run that same process less
than 10 minutes apart. Or, if you use a saved schedule that has an individual run in addition to the regular frequency, for
example a schedule that runs every 10 minutes and once at five minutes after the first run.

Define the Output
You can choose the layout, format, and destination for your output. Use the Process Details dialog box in Advanced
mode.

1. Open the Output tab, if available.
2. Click Add Output Document.
3. Change the name if you want. The name identifies this output document when you go to view output later.
4. Select a layout if you've more than one to choose from.
5. Select a format, for example one of these options:

◦ PDF: Is the best option if you want to print the output.

◦ Excel: Supports embedded images, such as charts and logos, but can be opened only in Excel 2003 or
higher.

◦ Data: Gives you report data in an XML file, which is used mainly for editing the report layout.

6. Click Add Destination to send the output somewhere, for example to a printer or email address. You can add
many destinations and send the output to all of them at the same time.

Tip:  You can also print the output as part of the steps for finishing the submission, instead of adding a
printer destination here.

7. To add more output documents, repeat steps 2 to 6.
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Set Up Notifications
You can have notifications sent out depending on how the process ends. Use the Process Details dialog box in Advanced
mode to set that up. These notifications are in English and they show times in UTC, no matter what language and time
zone the recipient has in their preferences.

1. Open the Notification tab.
2. Click Create Notification.
3. From the Address Type list, select whether you want to identify the recipient by their email address or user ID.
4. In the Recipient field, enter either the email address or user ID of the person you want to send the notification

to.
5. In the Condition list, select when to send the notification, for example when the process ends in error.
6. Click OK.
7. To send notifications to more people, repeat steps 2 to 6.

Finish the Submission
Follow these steps in the Process Details dialog box:

1. Click the Process Options button if you want to define settings that affect the data to be processed.
2. If the process gives you output and you want to print it, select the Print output check box and a printer.
3. Select the Notify me when this process ends check box if you want to get a notification. This notification is in

English and shows times in UTC, no matter what language and time zone you have in your preferences.
4. Enter submission notes to capture any information you want to associate with this submission. You can use

your notes to find this submission later.
5. Click Submit.
6. Click OK to confirm.

Tip:  Note down the process ID for your submission if you might need to easily find it later. For example, let's
say you set the process to run once a week. If you later want to cancel all runs on this schedule, you need to
cancel this original submission with the process ID you see.

Submit Process Sets
To submit a process set from the Scheduled Processes Overview page:

1. Proceed with the steps that you would follow to submit any scheduled process, but select Job Set for the Type
option.

2. In the Process details dialog box, set parameters for individual processes in the set. A process set itself doesn't
have parameters.

a. Select a process on the Processes tab.
b. Enter parameters for that process, if any.
c. Repeat for other processes in the set.

3. Define the schedule, output, and notifications for the process set, as you would do for any scheduled process.
4. Set any other options and click Submit.

Whether you use the Notifications tab or the Notify me when this process ends check box, or both, notifications are
sent when the entire process set ends, not when each process within the set ends.
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Related Topics
• Examples of Process Options

• Example of Process Details for a Process Set

• View Analytics, Reports, and Dashboards

• View Status and Other Details for Scheduled Processes

Examples of Process Options  
When you submit scheduled processes, click the Process Options button in the Process Details dialog box to set
options such as language and time zone.

Here are a few things to know:

• Your settings affect the data to be processed and what you get in the output.

• If the process is running on a schedule, your settings apply to every run.

• The settings override what's set in general preferences, which you can get to by clicking your user name in the
global header and selecting Set Preferences.

Let's take a look at some examples of process options that you can set.

Language
You set the language process option to Spanish, while the Current Session field is set to Japanese in your general
preferences. So, your output is in Spanish. If you don't set the language process option, the output is in Japanese.

Currency
You set the currency process option to Euro, while your general currency preference is set to Yen. The scheduled process
makes calculations based on the Euro, and the output shows all monetary amounts in Euro.

Example of Process Details for a Process Set  
When you're submitting a process set with the Process Details dialog box, you can open the Processes tab to see what's
in the process set. Here's the information you get for every process in the process set.

• Process Name: A process in the process set.

• Path: The step ID of the process, preceded by the step ID of the process set that the process is nested under, if
any. Every process and nested process set in the process set that you're submitting is considered a step and has
a unique step ID.

Tip:  If a process shows up more than once in the process set you're submitting, use the path information to
differentiate between those instances.

• Parent Process Set: The direct parent of the process, either the process set you're submitting or the process set
that the process is nested under.
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Scenario
Let's try to understand what we are looking at in the Processes tab. Say you're submitting a process set called Full
Cleanse and Import, which contains a Clean Records process and a nested Quick Import process set. The nested
process set has two processes, one of which is the same Clean Records process.

• Clean Records process (with a step ID of CleanRec1)

• Quick Import process set (QuickImpo1), which has two processes:

◦ Import Records process (ImpoRec1)

◦ Clean Records process again (CleanRec1)

This table shows what we see in the Processes tab for this example.

Process Name Path Parent Process Set

Clean Records
 

CleanRec1
 

Full Cleanse and Import
 

Import Records
 

QuickImpo1.ImpoRec1
 

Quick Import
 

Clean Records
 

QuickImpo1.CleanRec2
 

Quick Import
 

Manage Processes and View Output  

Statuses of Scheduled Processes  
After you submit a scheduled process, it can go through many statuses until it reaches a final state.

This table explains the statuses you might see. The Action Required column tells you if something can be done for the
process:

• No (in progress): The process was submitted and hasn't reached a final state yet. But you or administrators
don't need to do anything to move the process along.

• Yes: You or administrators need to do something to get the process to another status.

• No (final): The process has reached a final state, and nothing else can be done.

Status Description Action Required?

Blocked
 

At least one other running process is
incompatible with and currently blocking your
process. The situation will be automatically
fixed.
 

No (in progress)
 

Canceled
 

The process was canceled, and you can't restart
it.

No (final)
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Status Description Action Required?

 

Canceling
 

The process is currently moving to the
Canceled status.
 

No (in progress)
 

Completed
 

The main part of the process completed, and
postprocessing (such as sending notifications
and generating output) has started.
 

No (in progress)
 

Error
 

The process finished running and ended with
errors.
 

No (final)
 

Error Auto-Retry
 

The process ended with errors but will
automatically run again.
 

No (in progress)
 

Error Manual Recovery
 

The process ended with errors and requires an
administrator to move the process to a final
state.
 

Yes
 

Expired
 

The process didn't run and its schedule already
ended. You can't restart it, but you can resubmit
with the same parameters or submit a new
process.
 

No (final)
 

Finished
 

The process ran based on a schedule, and it's
either a process set or a process that causes
other processes to automatically run. Either
way, all processes involved are done running.
 

No (final)
 

Hold
 

The process is put on hold and needs someone
to release it before it can continue running.
 

Yes
 

Paused
 

The process is paused so that another process
that was automatically kicked off can run first.
 

No (in progress)
 

Pending Validation
 

Some validations, for example related to
security, are performed on the process before it
runs.
 

No (in progress)
 

Ready
 

The process passed validation and is about to
start running.
 

No (in progress)
 

Retrying
 

The process resulted in an error but will try
again. It will automatically rerun at the time
you see in the Scheduled Time column on
the Scheduled Processes Overview page. The
number of retries depends on how the job is set
up. After all the retries, if the process still can't
run successfully, it will end with the Error status.
 

No (in progress)
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Status Description Action Required?

Running
 

The main part of the process is currently
running.
 

No (in progress)
 

Schedule Ended
 

The last submission in a schedule has
happened for a process that's either a process
set or a process that causes other processes
to automatically run. Either way, all processes
involved have started running, but might not be
done yet.
 

No (in progress)
 

Succeeded
 

The process successfully completed.
 

No (final)
 

Validation Failed
 

The process failed validation.
 

No (final)
 

Wait
 

The process passed validation but isn't running
yet.
 

No (in progress)
 

Warning
 

The process finished running and ended with a
warning, for example, that a notification wasn't
sent.
 

No (final)
 

Related Topics
• View Status and Other Details for Scheduled Processes

View Status and Other Details for Scheduled Processes  
After you submit a scheduled process, you can track its progress. Processes can finish running in seconds, or a few
minutes, or even longer.

If something interrupts a process while it's running, for example a server restarting, then the process automatically
picks up where it left off. If you need to see all processes, not just the ones you submitted, ask your security
administrator to assign you a custom role that has the ESS Monitor Role (ESSMonitor) or ESS Operator Role
(ESSOperator).
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Here's where you can find processes that were submitted:

• Scheduled Processes work area

• Other work areas with a section for scheduled processes, if available.
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Check the Status in the Scheduled Processes Work Area
Here's how you find your scheduled process and see how it's doing.

1. Click Navigator > Tools > Scheduled Processes.
The Search Results table shows processes that were submitted in the last hour because the default saved
search is Last hour. The table might be blank if nothing was submitted in the last hour.

2. If you don't see the process, click the Refresh icon or run a search. For the search, enter your own criteria or
select another saved search. Here are a few examples of saved searches you can use:

◦ Last 24 hours

◦ Last 72 hours

◦ Cancelable Processes

Tip:  In the search results, select Hierarchy for the View option to see, for example, the structure of nested
processes or process sets within a process set. For processes running on a recurring schedule, the parent
node is the original submission, the child nodes each run in the schedule.If submission notes were entered
when submitting the process, you can use the Submission Notes column to help identify the process.

3. Refresh the search results at any time to see the latest status of the process in the Status column. You can also
check the Start Time column to see if the process has started running yet.

Note:  Times such as start time and scheduled time are shown in the time zone you set in your preferences.
If you change your preferences, you can see the change in the Scheduled Processes work area next time you
sign in.

4. To get more details about the status, select your process in the Search Results table and open the Status Details
tab. Here’s some of the information you might find:

◦ Status description, which explains what the current status means.

◦ The position of the process with the Ready status, in the sequence of submitted processes. For example,
if your process is queued up for submission at position 5, there are four processes that need to start
running before your process starts.

◦ Duration of a process, based on its current status.
- How long process has been blocked: If a process is blocked, you can see how long it has been in

the blocked status. For blocked processes, you can also expand the Incompatibility section to get
information about which incompatible processes are preventing yours from running.

- How long process has been running: If a process is running or completed, you can see how long it
has been in the running status. If your process is in progress, and it’s blocking other processes, you
can also see IDs of those processes, which can’t run until yours is done.

- How long process took to complete: If a process is completed, you can see how long it took to
complete with Error, Finished, Warning, or Succeeded status.

◦ On the Status Details tab, you can also expand the Status of Items to Process section, if available.
Here are a few things to know about the Status of Items to Process section:

- This section isn't available for process sets. But, it's available for individual processes, including
those within process sets, that are in these statuses:

◦ Running

◦ Completed

◦ Succeeded
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◦ Error

◦ Error Auto-Retry

◦ Error Manual Recovery

◦ Canceled

◦ Canceling

◦ Warning

◦ Hold

◦ Paused

- If a specific process is predefined to show progress information through graphs, you can see that
information in one or more graphs. For example, a process importing lines from a file might show
a graph called Lines. You hover over parts of the graph to see how many lines are successfully
imported, how many ended up in error, and how many are still pending. A process can have
multiple graphs, depending on what it’s working on.

5. With your process still selected in the Search Results table, optionally click the View Log button (if available),
especially if information isn’t available in the Status of Items to Process section. The type of information in the
log varies, depending on the process. You can open the log from here only if the process is currently running.
When the process is done, you might want to also take a look at the final log, if any, from the Process Details
tab.

View Other Details in the Scheduled Processes Work Area
To get more information about a scheduled process, select it in the Search Results table and see the Process Details tab
that appears after the table. These are some of the details you might find:

• Completion text, which is automatically generated when the process reaches a final state. What you see
depends on the process. For example, it might say that the process finished 1792 records in less than a second.

• The log attachment, for example for details about why the process ended in error.

• Report output that the process generated, if any.

• Parameters for the scheduled process.

◦ Open the Parameter Names with Values subsection to see the parameters from the Process Details dialog
box and the values that were entered when the process was submitted.

◦ Use the All Parameter Values subsection for troubleshooting purposes, if you need to see the parameters
and values in their actual, technical format. This subsection might have more parameters. For example,
some processes run with additional parameter values that are derived from the parameter values you
entered when you submitted the process.

Monitor Scheduled Processes in Other Work Areas
Some work areas have a section where you can monitor the scheduled processes that were already submitted.

1. Go to the section if it's available, usually on the landing page of the work area.
2. Click the Refresh icon if you don't see any processes or need to see the latest status.

◦ If you still don't see the process you're looking for, try changing the filters. If that doesn't help, use the
Scheduled Processes work area instead.

◦ If submission notes were entered when submitting the process, you can use the Submission Notes
column to help identify the process.
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3. Do either of these things to check on the progress of the process:

◦ For more details about the status, click the status link. For example, if a process is in the Ready status,
you can click the Ready link in the Status column to see where the process is in the submission queue.

◦ Check the Start Time column to see if the process has started running yet. If it has, you can click the link
in the View Log column to get information about how the process is running.

Related Topics
• Statuses of Scheduled Processes

• What do I get if I view scheduled processes in a hierarchy?

• View Output from Scheduled Processes

• Cancel or Make Changes to Scheduled Processes

• Resubmit Scheduled Processes and Process Sets

Cancel or Make Changes to Scheduled Processes  
Life is full of second chances! After a scheduled process is submitted, you can still cancel it or make other changes in
the Scheduled Processes work area.

What you can do to the process depends on its status. Also, depending on what you've access to, you can even work on
processes that someone else submitted. If you need to cancel processes that someone else submitted, ask your security
administrator to assign you a custom role that has the ESS Administrator Role (ESSAdmin).

Make Changes to Processes
Select the scheduled process in the Search Results table. Here are some things you might be able to do.

Changes you can Make to Processes

Task Prerequisite Procedure

Edit Schedule
 
Change the submission schedule, for example,
 to submit it biweekly instead of weekly.
 

This option is there only if you select the
row with the process ID you got when you
submitted the process to run on a schedule.
The row should be the parent node when you
view the search results in a hierarchy, and the
status should be Wait.

From the Actions menu, select Edit Schedule.

Edit Output
 
Change output options of a process, for
example, from HTML format to PDF.
 

You can do this only if the process generates
output, and hasn’t started running yet.

From the Actions menu, select Edit Output.

Put On Hold
 
Pause the process.
 

Click the Put On Hold button.
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Task Prerequisite Procedure

Release Process
 
Resume a process that's on hold so that it
continues to run.
 

Click the Release Process button.

Change Process Priority
 
Change the priority of a process to affect
when it runs. When there are many submitted
processes, those with a lower number, for
example 2, would usually run before those with
a higher number, for example 7.
 

You can do this only if your implementor has
enabled priorities for scheduled processes,
and you've a custom role that has the ESS
Administrator Role (ESSAdmin).
 
You can change priorities only for processes
that have the Blocked, Hold, Ready, or Wait
status.
 

Click the Change Process Priority button.

Note:  Even if the process hasn't started, you can't change the parameter settings. You can cancel the process and
submit again with the parameter values you want.

Cancel a Process
Select the scheduled process in the Search Results table, and click Cancel Process.

Cancel a Process Running on a Schedule

If you submitted a process to run on a schedule, for example once a day, you can cancel the scheduled runs even if
some of the runs already happened.

1. Find the original submission, the row with the process ID you got when you submitted the process. The row
should be the parent node when you view the search results in a hierarchy, and the status should be Wait.

2. Click Cancel Process.

When you cancel this original submission, you cancel any current and future runs based on the schedule you
had set.

What to Do If Processes Take a Long Time to Cancel

Sometimes it takes a while for a process to finish canceling. So, you can use the Actions menu to end it. The option you
get depends on the process.

Options and Descriptions

Option Description

Hard Cancel To end the process shortly after you canceled it, without waiting for the cancellation to finish by itself.

Force Cancel To end a process that has been canceling for over 30 minutes but isn't done yet.

Processes on Remote Servers
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Some processes run on a remote server. Even if the status for the process that you hard or force canceled has changed
to Canceled, the process might still be running on the remote server. With the scheduled process still selected in the
Search Results table, you check the status of the remote process on the Process Details tab that appears after the table.

Option You Used to End Your
Process

Field that Shows the Status of the
Remote Process

Status of Process on Remote Server

Force Cancel Remote Process Status • Completed Successfully: The remote process was successfully
canceled within the 30 minute grace period.

• Running/Unknown: Your scheduled process is in a Canceled
state, but the remote process is still running.

• Terminated: Your scheduled process is in a Canceled state, and
the remote process is successfully canceled after the 30 minute
grace period.

Hard Cancel External Job Status • Completed Successfully: The remote process has successfully
canceled.

• Running/Unknown: Your scheduled process is in a Canceled
state, but the remote process is still running.

Cancel Processes in Bulk
You can cancel up to 100 processes at once, as long as the processes haven't reached a final state.

1. Click Navigator > Tools > Scheduled Processes.
2. In the Search section, select Cancelable Processes from the Saved Search list.
3. Make sure that what you get in the Search Results table meets these requirements:

◦ No more than 100 processes

◦ Only processes with a cancelable status:

- Wait
- Ready
- Running
- Completed
- Blocked
- Hold
- Paused
- Pending Validation
- Schedule Ended
- Error Auto-Retry

4. Use the Search section to change your search results, if you need to.
5. Select Cancel Processes in Bulk from the Actions menu.

Related Topics
• View Status and Other Details for Scheduled Processes

• Allow Updates to Scheduled Process Priority
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Resolve Blocked or Incompatible Processes  
If your scheduled process has a Blocked status, that means another process that’s currently running is incompatible
with your process and preventing your process from starting. Incompatible processes can’t be running at the same time.

A process can be self-incompatible, which means it can’t start if another submission for the same process is currently
running. For example, if you get an error in the log saying that one or more requests are currently pending for
definition, that means the process is self-incompatible.

There are two types of incompatibilities:

• Global: Incompatible processes can never run at the same time, including self-incompatible processes.

• Domain-Specific: Processes are incompatible only if they also have another matching criterion. So you might
see that two processes are shown as incompatible, but notice that other submissions for the same two
processes are running at the same time.

If you were able to submit a process but it’s now blocked, here’s how you can find what’s incompatible:

1. Click Navigator > Tools > Scheduled Processes.
2. Select your process in the Search Results table and open the Status Details tab.
3. Expand the Incompatibility section to see which processes are incompatible with yours.

When you have a blocked process, you can go with one of these options:

• Wait for the incompatible process to finish running so that yours can start. Optionally find that process in the
Search Results table and track its status.

• Cancel the incompatible process. For processes running on a schedule, view search results in a hierarchy and
cancel the child node the represents what's currently running. Even after you cancel, it’s possible your process
won’t start immediately, depending on how many other submissions there are.

• Put the incompatible process on hold so that your process can run. You might need to resubmit your process.
For processes running on a schedule, view search results in a hierarchy and put on hold the child node the
represents the next run. Release the process after yours is done running.

View Output from Scheduled Processes  
Other than processing records, some scheduled processes also give you output. When you submit the process, you can
select the output layout and format, and set other output options.

In the Scheduled Processes work area, you can view the output and even republish it in a different format without
resubmitting the process. You might be able to see the output from other work areas too.

When You're In the Scheduled Processes Work Area
Here's what you do:

1. Click Navigator > Tools > Scheduled Processes.
2. Find your scheduled process and, if you need to, refresh the search results to see the latest status.
3. Select the scheduled process.
4. Go to the Output subsection on the Process Details tab.
5. Click the link in the Output Name column to view or download the output, which you can then print.
6. To view or export the output in a different format, follow these steps:
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a. Click the Republish button.
b. Click the Actions icon.
c. Select Export, and then select a format.

If you want the Data format, you can also just click the XML Data icon instead.

Note:  On the Process Details tab, if you don't see an Output subsection, look for a Log and Output subsection. The
output might be there instead as an attachment. This is likely if the Output tab isn't available when you submitted the
process in Advanced mode.

When You're In Other Work Areas
Some other work areas have a section, usually on the landing page of the work area, where you can monitor the
scheduled processes that were already submitted. In the table there, find your process and click the Output icon in the
View Output column.

Related Topics
• Submit Scheduled Processes and Process Sets

Resubmit Scheduled Processes and Process Sets  
You can easily resubmit scheduled process using the exact same parameter values, if the process has a Succeeded
status and wasn't part of a submission involving other processes.

For process sets, you can also resubmit after changing any of the parameters or other options.

Resubmit Processes
In the Scheduled Processes work area, here's how you resubmit processes using the same parameters:

1. Click Navigator > Tools > Scheduled Processes.
2. In the Search Results table, select your process and take a look at its details, including parameter values.
3. Click Resubmit.

Some other work areas have a section, usually on the landing page of the work area, where you can monitor the
processes that were already submitted. In the table there, you can also select your process, see its parameter values, and
click the Resubmit button.

Resubmit Process Sets
Resubmit process sets from the Scheduled Processes work area, not other work areas.

1. Click Navigator > Tools > Scheduled Processes.
2. See process details, including parameter values, for the processes that ran as part of your process set.
3. In the Search Results table, select your process set.
4. Click Resubmit, and you're done. Or, click the Resubmit drop-down button and select Resubmit with

Changes.
a. In the Process Details dialog box, select a process on the Processes tab.
b. Change any of the parameters.
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c. Repeat and change parameters for any of the other processes in the process set.
d. Define anything else as part of the submission, for example the schedule.
e. Click Submit.

Both options to resubmit are available for process sets in either of these situations:

• The process set has any of the statuses in a final state, for example Succeeded or Canceled.

• The process set ran on a schedule and has either the Wait or Schedule Ended status. The option applies only
to the original submission, the row with the process ID you got when you submitted the process to run on a
schedule. The row would be the parent node when you view the search results in a hierarchy.

Related Topics
• Submit Scheduled Processes and Process Sets

• View Status and Other Details for Scheduled Processes

FAQs for Scheduled Processes  

Which role gives me access to the Scheduled Processes work area?
 
Any that has the Manage Scheduled Processes (FND_MANAGE_SCHEDULED_PROCESSES_PRIV) privilege. Ask your
security administrator to assign you a custom role with this privilege.

Why can't I see Scheduled Processes in the Navigator or home
page?  
If you have a role that should give you access, but you still can't see Scheduled Processes in the Navigator or on the
home page, it's possible that the work area isn't currently available to anyone.

Your administrator should make sure in the Structure work area that EL Expression is selected for the Show on
Navigator list, and the EL expression is this:

#{(securityContext.userGrantedResource
['resourceType=FNDResourceType;resourceName=FND_Scheduled_Processes_Menu;action=launch'])}

Why can't I find the scheduled process that I need to run?  
It's possible that you don’t have access to it. Ask your security administrator to assign you a role with the privilege that
gives you access to that process. This is especially likely for custom processes.

When your administrator creates a new job definition, a new privilege is automatically created, and it's not assigned to
anyone by default.
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What's the maximum number of scheduled processes that can run
at the same time?  
It depends on the setup for your cloud service. If you need more information, contact your help desk.

What do I do if I can't find scheduled processes that were already
submitted?  
Some of the work areas where you do your business tasks might have a section you can use to monitor scheduled
processes.

If the process you're looking for here was submitted before anything in the Time Range filter, then go to the Scheduled
Processes work area (Navigator > Tools > Scheduled Processes). There, you can set the Submission Time criterion, for
example, to search for processes that were submitted after a certain date or between the dates you specify.

If you're in the Scheduled Processes work area and still can't find your process, check if you've noted somewhere
when the process was submitted or when it ran. Processes that finished a while ago might not be available any more.
Processes can be kept for at most 60 days, but it might be much shorter, for example 7 or 15 days.

What do I get if I view scheduled processes in a hierarchy?  
When you select Hierarchy for the View option, you might see some search results in a hierarchical structure. Here are
some possibilities for what the hierarchy can represent.

Hierarchy View

Parent Node Child Nodes

A submitted process set. The nested processes or process sets within the submitted process set.

A process or process set submitted to run
on a schedule.

Each run in the schedule.

A process or process set that causes other
processes to run automatically.

The other processes that run.

Related Topics
• Process Sets
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Why doesn’t the time zone for a submitted process match the time
zone I used to submit or search for the process?  
When you submit a process, you can select the time zone to use to define a recurring schedule.

You can also click the Process Options button and set a time zone just for that submission, which affects for example
any parameters and output. When you search by submission time in the Scheduled Processes work area, you can also
select a time zone.

But, when showing information about processes that were already submitted, the work area always reflects the time
zone you set in your preferences. For example, this applies to the scheduled start time you see in the Search Results
table and the Process Details tab. If you change your preferences, you can see the change in the Scheduled Processes
work area next time you sign in.

How do I cancel or make changes to scheduled processes that are
submitted to run on a recurring schedule?  
First, if you can, find the process that was submitted on a recurring schedule by its process ID.

If you don't have the process ID, here's how you find it:

1. In the Scheduled Processes work area, search by the process name, the Wait status, and a submission time
before the current date.

2. For the search results, select Hierarchy for the View option.
3. Select the parent node that represents the process submitted to run on a schedule.

With the process selected in the Search Results table, select what you want to do from the Actions menu. For example,
Edit Schedule to change the end date or frequency, or Cancel Process to cancel the original submission and all
remaining runs.

If the Edit Schedule option isn't available, it's likely that the process was submitted outside the application, for example
through a SOAP web service. And, the schedule was defined with iCalendar in a way that doesn't map to what you can
define on the Edit Schedule page.

Why can't I force cancel a scheduled process?  
The Force Cancel option is available only if the process has already been canceling for more than 30 minutes.

For some processes, you get a Hard Cancel option instead, which is available soon after you cancel the process. Which
option you get depends on the process.
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How can I export search results for scheduled processes to a
spreadsheet?  
Here's what you do:

1. Click Navigator > Tools > Scheduled Processes.
2. On the Overview page, expand the Search section and run your search.
3. If you're happy with the search results, click the Download Results button in the Search section.
4. In the Download Results dialog box, select the number of records you want to export.
5. Select the Include Job's item counts check box to include an Items to Process (Success/Error/Total) column

in the spreadsheet.
6. Click Download.

Tip:  If you see any difference between the spreadsheet and the Search Results table, refresh the table and then
compare again.

Why don’t notifications reflect my language or time zone?  
All notifications for scheduled processes are in English and show times in UTC, no matter what language and time zone
you have in your preferences.

This applies to notifications you get when you select the Notify me when this process ends check box. Or, when you
set up notifications in the Notifications tab when you're submitting the process in Advanced mode.

Can I get notified every time a process within a process set ends?  
No, notifications are sent only when the entire process set ends, not when each process within the set ends.

What happens to processes scheduled by a user who is no longer
here?  
If a user is inactive, for example because they left the company, the processes they submitted on a recurring schedule
won't run.

For security reasons, it's best that you cancel that submission and schedule a new one if still needed. The same
situation applies to users who are locked or failed to authenticate.
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Why am I getting an error about view definition not being found,
when submitting a job definition?  
When you’re submitting a custom job definition, this error is sometimes shown, if the custom job was created by a user
whose user name contains spaces.

Ask your administrator to create the custom job definition, using a user name that doesn’t contain spaces.

What do I need to do if my scheduled process is stuck in canceling
status for long in Fusion Applications?  
Select the scheduled process and use the Actions menu from the Search Results table of the Scheduled Processes
work area to end it.

This table provides information on the options you get depending on the process.

Option Description

Hard Cancel To end the process shortly after you canceled it, without waiting for the cancellation to finish by itself.

Force Cancel To end a process that has been canceling for over 30 minutes but isn't done yet.

Some processes run on a remote server. Even if the status for the process that you hard or force canceled has changed
to Canceled, the process might still be running on the remote server. With the scheduled process still selected in the
Search Results table, you check the status of the remote process on the Process Details  tab that appears after the
table.

This table lists the options you can use to end your process.

Option You Use To End Your Process Field that Shows the Status of the Remote
Process

Status of Process on Remote Server

Force Cancel Remote Process Status • Completed Successfully: The remote
process was successfully canceled within
the 30 minute grace period.

• Running or Unknown: Your scheduled
process is in a Canceled state, but the
remote process is still running.

• Terminated: Your scheduled process is in a
Canceled state, and the remote process is
successfully canceled after the 30 minute
grace period.

Hard Cancel External Job Status • Completed Successfully: The remote
process has successfully canceled.
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Option You Use To End Your Process Field that Shows the Status of the Remote
Process

Status of Process on Remote Server

• Running or Unknown: Your scheduled
process is in a Canceled state, but the
remote process is still running.

If Force Cancel is unavailable, act according to your specific scenario listed in this table.

Scenario Action

Less than 30 minutes have passed since
the cancellation was initiated.

Let the cancellation process run for at least 30 minutes. After this time, check the status of the
scheduled process again. If Force Cancel becomes active, you can use it.

The process is synchronous. If a synchronous process remains in canceling status and the Force Cancel option isn't available, you
can contact your help desk.

The process is a parent of recurring
asynchronous processes.

Check the status of all child processes. When all associated child processes are in a canceled status, the
status of the parent process will automatically update from Canceling to Canceled.

Where to Find Information About Specific Scheduled
Processes  
Here's some information about specific scheduled processes that you might have access to, depending on the products
you're using and the roles you have. This isn't a comprehensive list of all available processes.

• Common features
See: Where to Find Information About Common Scheduled Processes

• Oracle Fusion Cloud Sales Automation and Oracle Fusion Cloud Fusion Service
See: Where to Find Information About Oracle Sales Scheduled Processes
See: Where to Find Information About Fusion Service Scheduled Processes
See: Where to Find Information About All Common CX Scheduled Processes

• Oracle Fusion Cloud Financials
See: Where to Find Information About Financials Scheduled Processes

• Oracle Fusion Cloud Human Capital Management
See: Where to Find Information About HCM Scheduled Processes

• Oracle Fusion Cloud Procurement
See: Scheduled Processes for Procurement

• Oracle Fusion Cloud Project Management
See: Where to Find Information About Scheduled Processes in Projects
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• Oracle Fusion Cloud Student Management

See: Where to Find Information About Student Management Scheduled Processes

• Oracle Fusion Cloud Supply Chain & Manufacturing

See: Scheduled Processes for SCM

Related Topics
• Best Practices for Scheduled Processes in Fusion Applications

Where to Find Information About Common Scheduled
Processes  
Here are many of the scheduled processes that are available as part of common features.

Approvals and Workflow
• Archive Transaction Console Completed Transactions

See: Archive and Purge Transactions

• Create Search Index for Worklist

See: Set Up the Approvals Work Area

• Employee Vacation and Delegation Rules Report

See: Review Employee Vacation and Delegation Rules

• Extract Workflow Tasks for Archive

See: How Workflow Tasks Are Archived and Purged

• Process Translations for Workflow Tasks Archive

See: How Workflow Tasks Are Archived and Purged

• Refresh Transaction Administrator Console Transaction Status

See: Automatically Refresh Transaction Statuses

• Run Reassign Pending Approvals for Terminations and Correct Invalid Supervisor Assignments Process

See:  How You Can Regularly Reassign Pending Approvals for Workers That Become Inactive

• Synchronize Notifications in Global Header

See: How do I sync in-app notifications for all users in Fusion Applications?

• Upload Workflow Task Attachments for Archive

See: How Workflow Tasks Are Archived and Purged
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Business Intelligence
• Create Rules XML File for BI Extender Automation

See: Overview of the Essbase Rule File and Cubes

• Import Oracle Fusion Data Extensions for Transactional Business Intelligence

See: Overview of Flexfield Change Import

Data
• Diagnose and Synchronize Application Data

See: Diagnose and Synchronize Application Data

• Load Interface File for Import

See: Load Interface File for Import Process

• Purge Interface Tables

See: Purge Interface Tables

Flexfields
• Upload Comma-Separated Value Files for Import Process

See: Upload Comma-Separated Values File for Import Process

• Upload Value Set Values

See: Upload Value Set Values Process

• Synchronize Flexfields with Business Objects

See: How can I resolve synchronization issues between flexfields and business objects in Fusion Applications?

Search
• ESS job to create index definition and perform initial ingest to OSCS

See: What do I do if I get errors about enabling the search extension framework?

See: What do I do if I get errors stating that the Oracle Search Cloud Service or OSCS isn't reachable?

• ESS job to run Bulk ingest to OSCS

See: Enable Search Extension Framework

• ESS process to check Search Cloud Service availability

See: What do I do if the process for creating indexes keeps failing?

See: What do I do if I get errors stating that the Oracle Search Cloud Service or OSCS isn't reachable?
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Security
• Import User and Role Application Security Data

See: Configure the Security Console

• Import User Login History

See: Schedule the Import User Login History Process

• Inactive Users Report

See: Inactive Users Report

• Locked Users

See: View Locked Users and Unlock Users

• Password Expiry Report

See: Password Expiry Report

• Retrieve Latest LDAP Changes

See: Retrieve Latest LDAP Changes

• Send User Name and Password Email Notifications

See: How can I notify users of their user names and passwords?

• User and Role Access Audit Report

See: User and Role Access Audit Report

• User Password Changes Audit Report

See: User Password Changes Audit Report

• User Role Membership Report

See: User Role Membership Report

Trees
• Manage All Trees Operations Centrally

See: Copy, Audit, and Flatten Tree Versions Using a Scheduled Process

Related Topics
• Best Practices for Scheduled Processes in Fusion Applications
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10  Transactional Business Intelligence (OTBI)
Analyses, Dashboards, Reports, and Infolets

Reporting and Analytics: Overview of Analyses,
Dashboards, Reports, and Infolets  
In OTBI reporting and analytics, you analyze business intelligence analyses, dashboards, and reports to gain insight that
you can act on and use to meet specific requirements.

You can use different types of predefined analytics, dashboards, reports, and infolets or create and edit them to support
your business needs.

Analyses, Dashboards, and Reports
There are three main objects you use to analyze your data and business.

Object What It Displays What You Use It For

Analysis
 

Data in an interactive format, for example a
table or graph.
 

Summarize or break down simple, real-time
data, which helps you in taking short-term
decisions.
 

Dashboard
 

A collection of analyses and other content,
 presented on one or more pages, or tabs.
 

Get various pieces of information about a
particular subject.
 

Report
 

Data in a predefined format that provides little
or no interaction.
 

Get high-volume data in a high-fidelity
output optimized for printing, for example in
documents to support internal operations,
statutory requirements, and other business
needs.
 

Note:  You can export tables on UI pages to Microsoft Excel workbooks, where available, and use the exported data for
analytical purposes.

For more information, see the Creating and Administering Analytics and Reports guides and the Using Analytics and
Reports guides (if available) for your products.

Create and Edit Analytics and Reports
You can create and edit analytics and reports for your own use, or make changes to objects for others, if you have the
appropriate roles to do so.
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Here are a few examples of the changes you can make.

• Add or remove columns from an analysis.

• Change the branding logo on report output.

• Create a dashboard to include your most commonly viewed analyses.

For more information about creating and editing analytics and reports, see the Creating and Administering Analytics
and Reports guides for your products.

Related Topics
• View Analytics, Reports, and Dashboards

View Analytics, Reports, and Dashboards  

Watch video
 

There are different ways to view and work with your analytics and reports. You can view analyses, dashboards, and
reports in the course of your work, on your usual pages and infolets. Or you can find them in the business intelligence
catalog with the Reports and Analytics work area and the Reports and Analytics panel tab.

View Analytics in Infolets
Use your favorite infolet pages to find analytics.

1. Use the page controls and Previous and Next icons to explore infolet pages in the home page, where they may
appear in infolets with summaries and aggregations or performance metrics. You may also find infolets in some
work areas.

2. Click an infolet to open a detailed analysis. So for example, if an infolet has transactions summed to a total, click
it to view details of the underlying transactions.

3. Click Done.

View Objects in Familiar Work Areas and Pages
Use analyses, dashboards, and reports available in your usual pages and work areas.

1. Explore your pages. Some may include analysis and report links or embedded objects, sometimes in tabs or
panel tabs.

2. Some work areas have a Reports and Analytics panel tab, where you explore catalog folders for relevant
analyses and reports for the work area. And if you have permission, you can map more objects to the work area
if they're appropriate.

a. Open the panel tab.
b. Expand the Shared Reports and Analytics folder and explore the available content.
c. Click the link for any object and see its type to determine whether it's an analysis, a report, or a

dashboard.
d. Click View to open the object.
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View Objects in the Reports and Analytics Work Area
Use the Reports and Analytics work area to search or browse the catalog and view any analysis, dashboard, or report
you have access to. It opens at the highest level of the catalog's folder hierarchy with all objects you have marked as
favorites.

Here are some things you can do in the Reports and Analytics work area.

1. Click Navigator > Tools > Reports and Analytics.
2. Filter and search for objects:

a. From the Filter list, select what you want to find.
b. To view objects you have marked as favorites, select Favorites in the list. Or select Recent Items to view

objects you recently worked with, or a recent search to run it again. Enter a name or part of a name and
click the Search icon.

c. In the search results, use the icons to identify what the objects are.
d. Click the name of an object to open it, or click More and select an action.

3. In the breadcrumbs, browse the catalog folders for analytics and reports. Click any Hierarchical Selector icon
to select a different node for the next level in the hierarchy.

4. Mark objects as favorites.

◦ Select Favorites in the Saved Searches to display your favorite objects.

◦ Click the Add Favorites icon for an object to mark it as a favorite.

◦ Click the Remove from Favorites icon to remove an object from your favorites.

5. Create and edit analyses and reports.

a. Click Create and select Report or Analysis.
b. Use wizards to create your analysis or report.

6. Click the Browse Catalog button (or click the More icon for a specific report, dashboard, or analysis) to use
more features.

Note:  If you don't see an analysis in the work area, browse the catalog for it. In the Catalog, select Show
Hidden Items to display any hidden analyses.

View Analyses
An analysis queries against your company's data and answers business questions with visualizations, such as charts
and tables. They may appear on your pages, or as parts of a dashboard.

1. From the catalog folders or search results, open an analysis to view.
2. Click Refresh to rerun the analysis and refresh its data.
3. Click Print and select either Printable PDF or Printable HTML to open a printable version.
4. Click Export to get analysis data in various formats, for example PDF, Excel, PowerPoint, comma-separated

value (CSV), and XML.

Note:  When you export data in a CSV format, dates are exported in raw format and converted to UTC time
zone.
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View Grouped Analyses in Dashboards
Some analyses are grouped in dashboards to give you meaningful related information. A dashboard contains pages of
analyses, prompts that filter information, and other objects.

1. From the catalog folders or search results, open a dashboard to view.
2. Select values for any dashboard prompts to filter the dashboard.
3. Click Apply to refine the results of all of the analyses in the dashboard.

View Reports
Reports show data in a predefined format that's optimized for printing.

1. From the catalog folders or search results, open a report.
2. Click the View Report icon if you want a different format.

◦ Choose HTML or PDF to display the report in a format for printing. Because it's optimized for printing,
PDF often provides the best results.

◦ You can also export the report as RTF for editing in a word processor, or as Excel or PowerPoint.

3. From the catalog folders or search results, you can also do these tasks:

◦ Click Edit to edit the report properties, layout, and data model.

◦ Click Report History to see details about past submissions of the report.

◦ Click Schedule to schedule the report to be run.

Where to Find More Information About Analytics and
Reports  
Here are some resources to help you get started.

• See the Analyze and Report page for your cloud services in the Oracle Help Center (http://docs.oracle.com).

◦ Enterprise Resource Planning
See: Financials Reports and Analytics
See: Procurement Reports and Analytics
See: Project Portfolio Management Reports and Analytics
See: Risk Management Reports and Analytics

◦ Human Capital Management
See: Global Human Resources Reports and Analytics
See: Talent Management Reports and Analytics

◦ Customer Experience
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See: CX Sales Reports and Analytics

See: Loyalty Reports and Analytics

◦ Supply Chain Management

See: Supply Chain Management Reports and Analytics

◦ Public Sector

See: Public Sector Reports and Analytics

• On these pages, you can review videos, guides, lists of predefined reports and analytics, and other resources
for using and creating analytics and reports.

Infolets  

Overview of Infolets  
An infolet is a small interactive widget that gives you key information and shows you what's going on in the areas you
work on. You might also find something in an infolet that you need to follow up on.

You can use infolets arranged in tabs in the Analytics section of your home page.

Here are a few things to know about infolets.

• Infolets have a front view, and might have a back and expanded view. Use the Back View, Front View, and
Expanded View icons at the bottom corners of an infolet to open these views.

• Your current infolet view persists as the default view the next time you sign in. For example, if you viewed a
back view of the infolet in your last session, you will see the same infolet view by default in your next session.

• Some infolets might also contain links to detailed reports. You can click anywhere in the infolet area to drill
down to the detailed report.

• You can also personalize the infolets. For example, you can move or hide them on the infolets page.

• If you don't see infolet pages on your home page, then your administrators must have disabled them to show
on the home page.

Note:  Some SCM or Procurement Cloud infolets might function differently from other infolets.

Here's how an infolet page looks.
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Personalize Infolets  
You can personalize the infolets on your infolets page, such as you can edit their titles and views, move them, or hide or
show specific infolets on the infolets page.

Edit Infolet Titles and Views

1. Click the Actions icon on the top right corner of the infolet, and select Edit Title and Views.
2. Edit the infolet title, and enable or disable the infolet views.
3. Click Save and Close.

Reorder Infolets
You can change the position of an infolet within an infolet page.

1. Click the Infolet Repository icon, and select Reorder Infolets.
2. In the Reorder Infolets dialog box, select the infolets, and use the arrows to reorder them.

Tip:  To select multiple infolets, press the Ctrl key, and then select them.

3. Click Apply.

Hide or Show Infolets
To hide an infolet from an infolet page, click the Infolet Repository icon, and deselect the infolet from the list of
infolets.

96



Oracle Fusion Cloud Applications
Using Common Features

Chapter 10
Transactional Business Intelligence (OTBI) Analyses,

Dashboards, Reports, and Infolets

Tip:  Alternatively, click the Actions icon on the top right corner of the infolet, and select Hide.

To show a hidden infolet on an infolet page, click the Infolet Repository icon, and select the infolet from the list of
infolets.

Related Topics
• How can I configure how infolets are displayed in Fusion Applications?

How You Use and Personalize Infolets in Oracle Fusion Cloud SCM
and Procurement  
Oracle Fusion Cloud Supply Chain & Manufacturing (SCM) and Oracle Fusion Cloud Procurement infolets are visual,
actionable, and personalized information cards summarizing critical data about specific objects.

These infolet cards are combined in a SCM or Procurement home experience or work area home page to make key
performance indicators easy to view, understand, and act upon.

You can do these with infolet cards:

• Flip or expand the card to view additional details about the object featured in the infolet card.

• Drill down to more details by navigating to relevant manage pages from the infolet view.

• Change the context of the card either at page level or at view level.

• Hide infolet cards.

• Reorder infolet cards.

Flip and Expand Card
Some infolet cards have a back view or an expanded view that provides additional information relevant to specific
aspects of the object being featured in the infolet card. The back and expanded views of the infolet card display
additional levels of detail and expose useful information relevant to the object. Based on how the infolets have been
configured, you can then navigate to either the back view or the expanded view.

To see different views of the infolet card, do the following:

• Click the Back View icon present on the infolet card to see the back view with additional information about the
object.

◦ To return to the front view, click the Front View icon present on the infolet card.

• The expanded view is available from either the front view or the back view. Click the Expanded View icon to see
useful information about the objects. Click the Front View or Back View icon to return to the view you started
with.

Additional Pages
Click the number or an element like a segment on the pie chart of the infolet card to navigate to relevant manage pages
with additional, in-context information. Drill down to view additional relevant information on related objects that will
help you to act on the latest and critical data points. For example, suppose you've an infolet card that displays draft
orders with errors. Each number or the segment of the graphical element represents the different error conditions such
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as pricing errors, processing constraint errors, and so on. Click the segment that represents draft orders in pricing errors
to see the names and additional details of all the draft orders with pricing error.

Context Selector
To view different perspectives of the same data, use context selectors. Two types of context selectors are available: at
the page level, and at the view level. Only some of the infolet cards have the view-level context selectors, while only
some pages with infolet cards have page-level context selectors. Context selectors aren't present on all infolet cards and
pages. If you change the context of the card on any view of the card, these changes may not necessarily reflect on the
alternate views of the infolet card.

• Each view of the infolet card may have a view-level context selector located after the title of the card. Select
from the list of available contexts and the view is updated based on that context. The view-level context can be
different on each view of the card.

For example, you may have an infolet card that displays information about fulfilled orders for different time
periods. Use the context selector to see information about orders that were fulfilled in the last three months.

• The page-level context selector is available on a tool bar of the page. The page-level context selector is similar
to the view-level context selector, except that all the cards on the page will display data as per the filters set in
the page-level context list. Click the View By icon on the tool bar of the page. Select the contexts from the two
available lists in the Page Context dialog box.

Examples include updating all of the cards to show data only for the last week, or only for a particular business
unit.

Hide Card
Click the Actions icon present on the infolet card, and select Hide. The selected card is hidden. You can also hide cards
by clicking the My Infolets  icon present on the page. A list of infolet cards is displayed. Deselect the check box of the
infolet card that you want to hide.

Rearrange Cards
The infolet cards can be moved around and can be rearranged or re-ordered on the page in any way you want.

Related Topics
• Infolets for New Item Requests
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Audit Reports  
You can use the Audit Reports work area to view changes to the application data, such as the business objects that were
created, updated, and deleted.

To view the history or to create a report, you must have a role with the View Audit History
(FND_VIEW_AUDIT_HISTORY_PRIV) privilege assigned to it. For appropriate assignment of roles and privileges, check
with your security administrator.

Audit Events
Transactional events in the application trigger the audit process based on the create, update, and delete operations. For
events to trigger the audit process for the business objects, you must first enable the objects for auditing.

These are the events that trigger the audit process.

Transactional Event When the Audit Activity is Triggered Audit Report Content

Create Whenever business object data is created and
stored in the database

• Name of the created object

• Name of the user who created the object

• Time of creation

Update Whenever the existing business object data is
updated

• Both old and updated values of the object

• Name of the user who updated the object

• Time of updating

Delete Whenever the existing business object data is
removed from the database

• The last value that the object attributes
contained

• Name of the user who deleted the object

The event details are stored in the audit table. The attributes of the audited object data can be used in lookups
and foreign keys to display values in the audit history. The application supports displaying the audited information
according to the language settings configured.

For Oracle Fusion Middleware products, events such as failed sign-in attempts are used as triggers. In absence of an
audit table, the information is stored in the sandbox and presented only in English.

Note:  This topic focuses on the create, update, and delete event types available in Fusion Applications. For details on
events used in the Oracle Fusion Middleware products, refer to the Oracle Fusion Middleware documentation. See:
Introduction to Oracle Fusion Middleware Audit Framework
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Related Topics
• View Audit Reports

View Audit Reports  
You can view the audit report for the business objects that are enabled for auditing. Remember, to view the history, or
to generate a report, you must have a role with the View Audit History (FND_VIEW_AUDIT_HISTORY_PRIV) privilege
assigned to it.

1. Click Navigator > Tools >  Audit Reports.
2. On the Audit Reports page, specify the search criteria.

Here's what some of the search criteria are for:

Search Parameter Description

Product Displays all the products that are available for auditing.

Note:  The checkboxes in the Search Results section are enabled or disabled based on the
product selected.

Business Object Type ◦ Narrows the search results to a specific business object, within the selected product.

◦ Enables the Show User-Related Details, Show Attribute Details, and Show Additional Object
Identifier Columns checkboxes in the search results.

Note:  If you're generating the audit history report of a scheduled process, you must select the
Business Object Type for your product. Otherwise, you'll get a blank report.

Include child objects ◦ Displays all the child objects that were listed for a business object when audit was set up. For
example, a sales order object that contains several items as child objects.

◦ Objects are displayed at the immediate parent-child level only. To view the children at subsequent
levels, select the child object as the business object type and search again.

Include attachment details This checkbox is displayed only when you select a business object associated with attachments.
 

◦ Displays additional event types for attachments in the Event Type list. These event types include
the check-in, checkout, and download options for the attachments.

◦ Based on the selection, information about the check-in, checkout, and download actions done on
attachments are displayed in the search results.

Show User-Related Details Displays the user ID.

Note:  For legacy data, also displays the name and ID of the impersonator who updated the
objects during an impersonation session.

Show Attribute Details ◦ Enables the attribute list so that you can select either all attributes, or a specific attribute to view
the changes.
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Search Parameter Description

◦ Based on the selection, the search results indicate whether an attribute is created, updated, or
deleted, and the corresponding old and replaced values.

Show Additional Object Identifier
Columns

◦ Displays the instances (contexts) in which the business object was used.

◦ The context values identify the objects and the transactions in which they were used. Each
context is unique and assigns a unique description to the business object.

For example, to get the audit report for all the insert and update operations of the business object type Item,
belonging to the product Product Hub, use these search parameters:

◦ From the Product list, select Product Hub.

◦ From the Event Type list, select Object Data Insert and Object Data Update.

◦ From the Business Object Type list, select Item.
You can also specify any other details from the search criteria.

3. Click Search.

In the Search Results section, you can see the audit report.

Tip:

◦ You can select the checkboxes in the Search Results section to view more information.

◦ Audit search results have limits on the amount of data they can process and so may not show all records
that meet your search criteria. You can try these solutions:

- Refine your search criteria and try again.
- You can export up to 10,000 records per entity in either Excel or CSV format. While exports

usually contain all data, bulk jobs exceeding this limit will only include the first 10,000 records.
- Run the Generate Audit Report scheduled process to display all records.

Related Topics
• Submit Scheduled Processes and Process Sets

Why is Last Update Date Different from Creation Date?  
Last Update Date in the audit report indicates when the changes to existing records were saved. For new records, this
Last Update Date might differ from the Creation Date.

That's because the Creation Date only indicates when the record creation began, and not when the changes were saved.
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Why can’t I see all the records in the generated report?  
Your report might have more number of rows than the set limit.

You can try one of these solutions:

• Contact your administrator to increase the limit.

• Refine your search criteria and search again.

Tip:  In such cases, usually, a message is displayed in the last row of the report. You can follow the suggestions in the
message and run the report again.

Can I get an Audit Report on changes made to the Audit
Policy?  
Yes, all the changes made to the products on the Manage Audit Policies page are audited and you can view them in a
report.

You can get a report on any of these activities:

• Changing the audit level

• Enabling or disabling auditing for a business object

• Adding or removing business objects and attributes

To get the audit report on changes made to the audit policy, specify these search criteria:

• From the Product list, select Audit Policies.

• From the Business Object Type list, select Oracle Fusion business objects and attributes.

Related Topics
• View Audit Reports

Why are unchanged columns showing up in the Audit
Report?  
After you enable auditing for columns and view the audit report, the newly audit-enabled columns show up in the audit
report, even if you haven’t changed the values in the columns.
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This happens because, before the columns are enabled for auditing, changes (if any) in those columns aren’t written
to the audit table. After auditing is enabled, these columns are also added to the audit table, and displayed in the audit
report.

For example, consider three columns, say, C1, C2, and C3, created on 1 Jan 2023. You add values in C1 and C2 columns.

Your database table displays these values.

C1 C2 C3 Last Update Date

c1value1 c2value1 null 01-Jan-2023

You enable auditing only for the C1 column, so the corresponding audit table will have these values.

Remember, the Last Update Date column is always audited.

C1 C2 C3 Last Update Date

c1value1 null null 01-Jan-2023

Three months later, you update the value in the C1 column and add a value in the C3 column.

Database table will have these values.

C1 C2 C3 Last Update Date

c1value2 c2value1 c3value1 01-Apr-2023

The corresponding audit table now has two rows, displaying the latest change for the audit-enabled C1 column.

C1 C2 C3 Last Update Date

c1value1 null null 01-Jan-2023

c1value2 null null 01-Apr-2023

Again, two months later, you turn on auditing for C2 and C3 columns. And update the value in the C1 column.

Database table will now have these values.

C1 C2 C3 Last Update Date

c1value3 c2value1 c3value1 01-Jun-2023

The corresponding audit table now has three rows.
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C1 C2 C3 Last Update Date

c1value1 null null 01-Jan-2023

c1value2 null null 01-Apr-2023

c1value3 c2value1 c3value1 01-Jun-2023

Although the C2 and C3 columns were last updated on 1 April 2023, the audit table shows these columns are updated on
1 June 2023. The audit table is added with the snapshot of the row, every time an update is made for the audit-enabled
columns. But here, the update for columns C2 and C3 is that they were enabled for auditing. Going forward, the audit
table will be updated for C2 and C3 columns only if there’s any change in the values in these two columns.
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Troubleshoot Issues  
When you run into issues that you can't easily fix yourself, you can follow a general process to troubleshoot the issue.
This process can involve error messages, diagnostic tests, recordings of the issue, and your help desk.

To troubleshoot issues, follow these steps:

1. If you get an error message, especially for an application-related error, the message might say that your help
desk is notified. Or, the message might advise you to contact the help desk yourself.
Either way, note down the message ID that appears after the message text, and the incident ID (if any) and
inform your help desk.

2. Run diagnostic tests if you have access to do so and can find tests relevant to your issue. Click your user image
or name in the global header to open the Settings and Actions menu, and select Run Diagnostic Tests.
If you can't run diagnostic tests, or can't resolve the issue after looking at test results, then go to the next step.

3. Contact your help desk and provide the IDs you noted in step 1, any diagnostic test results, and anything else
related to your issue.

4. If your help desk asks you to reproduce and record your issue, click your user image or name in the global
header to open the Settings and Actions menu, and select Record Issue.

5. After you finish recording, note down all the information about your recording (for example the recording ID)
and send it to your help desk.

6. Continue working with your help desk to resolve your issue.

Related Topics
• Run Diagnostic Tests

• Run Diagnostic Tests to Verify, Troubleshoot, and Analyze

• Record Issues to Troubleshoot

• What's an incident?

• How can I find information about specific issue recordings?

Diagnostic Tests  

Run Diagnostic Tests  
Use the Diagnostic Dashboard to identify and resolve issues within your application. You can run and monitor diagnostic
tests and review the test results using the Diagnostic Dashboard.

To run a diagnostic test, ensure that your user account is associated with one of the following job roles:

• Application Diagnostics Regular User (ORA_FND_DIAG_REGULAR_USER_JOB)

• Application Diagnostics Advanced User (ORA_FND_DIAG_ADVANCED_USER_JOB)
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• Application Diagnostics Administrator (ORA_FND_DIAG_ADMINISTRATOR_JOB)

To run a diagnostic test:

1. Click your user image or name in the global header, and from the Settings and Actions menu, select Run
Diagnostic Tests. If you don't see this menu item, then your help desk can make it available to you.

2. In the Search for Tests or Search for Tags panes, search for and identify the diagnostic tests that you want to
run.

3. From the search results, select the check box for the diagnostic test and click Add to Run. The selected test is
added to the Choose Tests to Run and Supply Inputs table.

4. In the Choose Tests to Run and Supply Inputs table, depending on the value that appears in the Input Status
column, perform the appropriate action. This table lists the values that may appear in the Input Status column
and the appropriate actions for each value:

Input Status Action

Required Input Values Missing
 

a. Click the Click to Supply or Edit Input Parameters icon in the Input Status column. In
the Input Parameters dialog box, specify the parameter values according to the parameter
type.

b. Click OK.

Note:
To skip that test and its nested test steps, deselect the Select to Run Test check box in the
Choose Tests to Run and Supply Inputs table.
 

Required Input Values Validated or
Input Values Validated
 

If you want to change an existing input parameter, or check the parameter values the test is
currently set to use:
 

a. Click the Click to Supply or Edit Input Parameters icon in the Input Status column.
b. In the Input Parameters dialog box, review the existing parameters or specify new input

parameters, as applicable.
c. Click OK.

No Inputs Specified
 

Proceed to step 4.
 

5. From the View menu in the Choose Tests to Run and Supply Inputs table, select Availability.
6. In the Diagnostic Test Availability dialog box, from the Select the Diagnostic Test for Details table, select each

test and check the icon displayed the Availability column.

◦ If the Availability column displays a check mark icon, then the selected test is currently available to be run.

◦ If the Availability column displays a warning icon, or if you want to determine whether the test is internal
or external, click Detach in the Available Details table header, and proceed to the next step.

If all the listed tests are available to be run, and you don't need to know whether they're internal or external,
proceed to Step 8.

7. In the detached table, here are a few things to do:

◦ If the Details of Required Test Components column contains the name of Oracle Fusion Cloud
Applications, then the test is an internal diagnostic test. Otherwise, it's an external diagnostic test.

◦ If the Error column contains an error message, take appropriate action to correct it.

8. Repeat steps 4 through 6 to verify that all listed tests are now available to run, and proceed to the next step.
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9. Optionally, you can enter a name for your test run in the Run Name field in the toolbar of the Choose Tests to
Run and Supply Inputs table. If you use the word error, or if you leave the Run Name field blank, the application
automatically assigns the test run a name.

10. From the Run Options menu, select the appropriate options depending on how you want the selected
diagnostic test or tests to run. This table lists the options available in the Run Options menu, and describes the
consequences of selecting each option.

Run Option Description

Run Now
 

Runs the selected test or tests immediately after you click Run.
 

Run Later
 

Schedules when the test or tests are run, if this option is available.
 
When you select Run Later, the Run button on the toolbar changes to a Schedule Run button.
Complete the following steps to schedule when the test or tests will be run:
 

a. Click the Schedule Run button.
b. In the Schedule Tests dialog box, click the Schedule tab and select Use a Schedule.
c. From the Frequency menu, select how often to run the selected test or tests.
d. In the Start field, specify the date and time at which to start testing.
e. Click Submit.

No Prerequisites
 

Runs the selected test or tests without running the prerequisite tests.
 

Run in Parallel
 

Runs the selected test or tests using multiple threads. The default value is 3, and you can select
any value from 2 through 5.
 

Run Synchronously
 

Runs the selected test or tests using a single thread.
 

11. Click Run.

Related Topics
• View the Status and Result of a Diagnostic Test

• Cancel an Initiated Diagnostic Test

• Run Diagnostic Tests to Verify, Troubleshoot, and Analyze

View the Status and Result of a Diagnostic Test  
Use the Diagnostic Dashboard to check the status and view the results of a diagnostic test. You can review information
about whether tests or test runs completed successfully, and if they detected any problems.
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Check the Status of a Diagnostic Test
To check the status of a diagnostic test using the Diagnostic Dashboard:

1. Click your user image or name in the global header, and from the Settings and Actions menu, select Run
Diagnostic Tests. If you don't see this menu item, then your help desk can make it available to you.

2. After running a diagnostic test using Diagnostic Dashboard, you may need to click Refresh to display the latest
status information.

3. Click the Run Status link in the Tasks pane.
4. If you want the Diagnostic Test Run Status table to display only certain types of rows, select the pertinent

option from the Find list.

Alternatively, click the Search Test Runs icon to search for specific rows in the Diagnostic Test Run Status table.
5. Expand the test run nodes to view the list of executions for each test.
6. In the Diagnostic Test Run Status table, review these statuses:

◦ Execution Status: This column displays status information about whether tests and test runs have
completed or encountered errors.

◦ Diagnostic Status: This column displays status information about whether the individual diagnostic tests
detected any problems before completing.

View the Result of a Diagnostic Test
To view the results of a diagnostic test, click the View Test Results icon in the Report column. You can review all the
details pertaining to that test.

Cancel an Initiated Diagnostic Test  
Use the Diagnostic Dashboard to cancel a diagnostic test that's running.

To perform this task, ensure that you have one of the following roles:

• Application Diagnostics Regular User (ORA_FND_DIAG_REGULAR_USER_JOB)

• Application Diagnostics Advanced User (ORA_FND_DIAG_ADVANCED_USER_JOB)

• Application Diagnostics Administrator (ORA_FND_DIAG_ADMINISTRATOR_JOB)

You need the Applications Diagnostic Administrator (ORA_FND_DIAG_ADMINISTRATOR) job role to cancel tests that
someone else ran.

To cancel a diagnostic test using the Diagnostic Dashboard, do the following:

1. Click your user image or name in the global header, and from the Settings and Actions menu, select Run
Diagnostic Tests. If you don't see this menu item, then your help desk can make it available to you.

2. Click the Run Status link in the Tasks pane.
3. In the Diagnostic Test Run Status table, verify that the Execution Status for the test you want to cancel is

Running.
4. Select the test you want to cancel and click Cancel.
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Run Diagnostic Tests to Verify, Troubleshoot, and Analyze  
When an error occurs, you can try to diagnose it yourself by running diagnostic tests, before following up with your help
desk.

You can also use diagnostic tests to take preventive measures and identify potential issues before running into real
problems.

Note:  You can run diagnostic tests only if you have roles that let you do so.

Health Check
This example shows running a diagnostic test to verify that data is correct before starting a large-volume task.

1. You are a general ledger manager, and you periodically run diagnostic tests to check on data, setup, and
configurations, especially before closing the period.

2. You open the Diagnostic dashboard and run the General Ledger Misclassified Accounts Validations test, to
make sure that all accounts are correctly classified.

3. You review the test results and confirm that the accounts are ready for the period close process.

Troubleshooting
This example shows running a diagnostic test to start the troubleshooting process.

1. You are a general ledger manager, and you run into issues with the period close process.
2. You open the Diagnostic dashboard and search for diagnostic tests using tags, with Financial Control and

Reporting as the tag name.
3. You browse the search results for tests with Close Ledgers as the tag value.
4. You find and run the appropriate test, General Ledger Closing Validations.
5. The diagnostic test results can show issues that you can't fix yourself: validation errors in setup, configuration,

or data integrity. In this case, it's incomplete accounting setup.
6. You notify your help desk about the diagnostic test results and describe your issue.

If the test results have no validation errors, but there are issues that you can't fix yourself, you can submit an
incident. The help desk reviews the incidents to identify the cause of the issue.

7. Your help desk troubleshoots the issue, suggests a fix, and asks you to rerun the test.
8. You repeat steps 4 through 7 until the test completes with no issues identified.

Data Analysis
This example shows running a diagnostic test to collect data for analysis.

1. You are a purchasing agent and you notice discrepancies in a specific purchasing document.
2. You search the Help for information related to purchasing documents, to see if you can find any relevant

troubleshooting information. You find a list of predefined diagnostic tests, and you check if there is a relevant
diagnostic test.

3. You open the Diagnostic dashboard and run the appropriate test: Manage Purchasing Documents Lifecycle -
Validate.

4. You review the test results that contain all the details about the particular purchasing document.
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5. You identify the reason for the discrepancies and resolve the issue yourself.

Related Topics
• Run Diagnostic Tests

• What's an incident?

Analyze User Session at Run Time  
Use the Application User Session Run Time diagnostic test to analyze a user's session. A session starts when users signs
in and ends when they sign out.

Run this test from the Diagnostic dashboard. Click your user image or name in the global header and go to
Troubleshooting > Run Diagnostic Tests.

Application User Session Cookie

Enter the cookie to identify the user session that you want to analyze.

To get the session cookie value:

1. Run the Application User Session Configuration diagnostic test to make sure that the ApplSession
configuration values for your application are correct.

2. Use a valid user name and password to sign in.
3. Display the list of cookies in your browser, according to instructions for the browser.
4. In the cookies listed for your domain site, select the cookie named ORA_FND_SESSION_<DATABASE_SID>.

◦ Your domain site is the host in the URL, for example oracle.com in the URL http://example.oracle.com.

◦ <DATABASE_SID> is your database session ID.

If you can't locate the cookie, then no application user session has been created for your application.
5. See the Content field, which has the format pillar_name:session_cookie_value:timestamp. For the

Application User Session Cookie parameter, enter the session_cookie_value part, which appears between two
colons.

Related Topics
• Run Diagnostic Tests

• Run Diagnostic Tests to Verify, Troubleshoot, and Analyze

Submit a Diagnostic Test Result as an Incident  
After you run a diagnostic test, if you observe any errors, you can submit the error details to your Oracle Support for
analysis. Here are the steps to add a test to an incident.

1. On the Diagnostic Dashboard, go to the Run Status section.
2. Click the Find list and select a relevant option to display the list of tests. Or, click the Search Test Runs icon and

specify a criteria to display the diagnostic test.
3. Select the diagnostic test that you want to submit and click Add to Incident.
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4. On the Select Incident dialog box, enter the following details:

◦ ADR Home: Search for and select the path of the Automatic Diagnostic Repository where you want to store
this test as an incident. If you don't know the path, check with your help desk.

◦ Problem: Select the predefined problem key to associate the test result with.

◦ Incident: Select the predefined incident type.

5. Click OK. You receive a confirmation that the test run report is successfully added to the specified incident and
stored in the specified ADR path.

Results:
Your Oracle Support team will be able to view this incident on their workbench dashboard.

Record Issues to Troubleshoot  
To help your help desk troubleshoot issues that you encounter in the application, you can record the issue while you
reproduce it.

Not only would the recording show your help desk what happened, but it also collects detailed data that your help desk
can analyze. You can also attach additional notes and material, such as screenshots, to most recordings.

Create a Recording
Follow these steps:

1. Open the page where your issue occurred. If the issue is that a page isn't opening or displaying properly, then
you can be on any page to start the recording before you try to open the problematic page again.

2. Click your user image or name in the global header and go to Troubleshooting > Record Issue. If you don't see
this menu item, then contact your help desk or security administrator.

3. For most issues, choose to collect page diagnostics while you're recording. Collect performance statistics only if
the issue is that the application is working too slowly.

4. Open the Advanced Options section (if you're given access) and set the recording time according to your help
desk or for as long as you think it would take to reproduce your issue. You can always stop the recording as
soon as you're done.

If you're collecting page diagnostics, you can take screenshots while you record and attach them to your
recording later. So take into account the time that it takes to capture screenshots.

5. If your help desk asks you to enter other advanced options, then fill out the rest of the section based on what
your help desk tells you.

6. Click Start Recording to record on the current page, or on the next page that you open immediately after you
click the button.

If you open yet another page after that, then the recording will automatically stop.
7. Click Stop Recording or record until the allotted time runs out.
8. If you're collecting page diagnostics, optionally add notes and attach screenshots or other relevant files to the

recording.
9. Note down your recording ID, and click Submit.

Tip:  You can later open the Record Issue dialog box again and click View My Recordings to find the ID and
other information about this recording.
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Related Topics
• What's the difference between the recording ID and the recording number?

FAQs for Troubleshooting  

What's a help desk?  
Your help desk might be an online tool, a team of people, or some other resource in your enterprise that assists you
when you run into problems with the software you're using.

If you contact your help desk to help you fix a software error, provide the full text of the error message you received,
including the message number.

What's an incident?  
An incident is a collection of diagnostic information for a critical application error. This information shows the state of
the application when the problem occurred.

If you get an error message for an issue severe enough to prevent you from continuing your work, you can submit an
incident. Any diagnostic tests associated with the error message are added to the incident, along with the test result.
Your help desk can view the incidents and suggest corrective action.

How can I find information about specific issue recordings?  
After you record an issue, you get a confirmation with the recording ID and other information to identify your recording.
To find this same information later:

1. Click your user image or name in the global header and go to Troubleshooting > Record Issue.
2. Click the View My Recordings button.

What's the difference between the recording ID and the recording
number?  
The recording ID is the unique identifier for your recording of an issue. Use the ID to find your recording later, for
example from a list of recordings.

The recording is stored on a server, and the recording number identifies it on the server. To get the actual recording files
from the server, your help desk needs the recording number and server information.
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How can I view the version information of an application?  
In the global header, click your user image or name and from the Settings and Actions menu, select About This Page.

The basic details about the application are visible by default. However, you must have appropriate roles to view the
version and release information, and other important details about the application.

What happens when the application is in maintenance mode?  
When an application is in maintenance mode, you see a message on the UI displaying either the scheduled start time or
the estimated completion time of the planned maintenance activity.

During the maintenance period, the background processes and tasks, such as scheduled processes or any report
generation activities, are put on hold. Also, the Setup and Maintenance work area is available in a read-only mode. After
the maintenance is completed, all modules return to their usual state.

Related Topics
• What are scheduled processes?

How does the help desk access and review the diagnostic
information?  
For application errors that you can't resolve yourself, your help desk can review the message diagnostic information and
attempt to resolve the issue.

Diagnostic messages contain different components:

• Message Text and Message Details: Describe the problem and are visible only to the users.

• Admin Details and Admin Action: Contain additional information meant for the help desk to guide them with
the resolution.

Note:  For your help desk to view the Admin Details and Admin Action components of a diagnostic message, set the
profile value for the Message Mode (FND_MESSAGE_MODE) profile option to Administrator.
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Get Help in the Application  
To get help for what you're working on, use help icons that are on many of the pages. The icons open help windows that
can have informational text, links to help content, and maybe even help that your company added.

Watch video
 

If you have an issue that you still can't resolve, you might need to contact your help desk or try to troubleshoot yourself
if possible, for example by running diagnostic tests.

Use Help Windows
Here's what you do:

1. Click a help icon. The help window gives you information specific to the page or part of the page that the icon is
on.

2. In the help window, click any of the links available.

◦ You see help links in your preferred language only if there's content in that language. If not, you see links
in English.

◦ Help content opens in a new browser tab so you can keep that open while you work.

◦ You can do more with the help than just read it. Options can include sharing or downloading the help.

3. Most of the links open guides in the Oracle Help Center.

◦ Use the Contents panel to move around in the guide for other information. Or, to search within the guide,
use the search in the Oracle Help Center global header.

◦ You can also use the On this page panel, if available, to jump directly to a specific section of the help
that's currently open.

Click the Close or Open icon to hide or show either panel at any time.

What to Do If You Don't See Help Icons
If you don't see any help icons on the page, click your user image or name in the global header and select Show Help
Icons. You reveal any icons on your current page, and any other page you might use, but not all pages have help icons.
In that case, click your user image or name in the global header and select Applications Help to open the Oracle Help
Center.

Related Topics
• Find Guides, Readiness Material, and Other Resources

• What's a help desk?

• Troubleshoot Issues

• Oracle Help Center
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Find Guides, Readiness Material, and Other Resources  
The Oracle Help Center has guides, videos, readiness material, playbooks, and other resources for Oracle Fusion Cloud
Applications.

Watch video
 

Browse for Content
1. From anywhere in the Oracle Help Center, open the main menu and click Cloud Applications > Fusion

Applications Suite. Or, click Fusion Applications Suite on the Help Center home page.
2. On the Oracle Fusion Cloud Applications Suite page, click the name of your product.
3. Use the side navigation to find a specific resource, for example:

◦ All Books: See all the guides for the product.

◦ Cloud Readiness / What's New: Learn what's new or changed in a particular release update. Readiness
material is published before the update happens, to help you prepare for it.

◦ APIs & Schema: Get reference information about REST APIs, tables and views, and more.

Tip:  Use the breadcrumbs to get to other parts of the Help Center.

Search for Content
The filter in the search bar controls the scope of your search. The filter you get depends on where you’re at in the Help
Center. For example, on a page for a specific product, you get search results only from that product. When you have a
guide open, you search within that guide.

Tip:  No matter where you’re at, you can remove the filter in the search bar to search across the entire Help Center.

After you get your search results, you can apply more filters, for example to see only videos published within the past
year. Search results might come from places other than the Help Center, for example My Oracle Support or oracle.com.

Review Readiness Material
Watch video

 
From anywhere in the Help Center, open the main menu and click Cloud Applications > Cloud Applications
Readiness. On the Cloud Applications Readiness page, use the side navigation to access readiness material.
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Examples of Release Readiness Resources

Entry in Side Navigation Readiness Resource

Create or View Reports A report that lists features for the specific pillars, products, modules, and release updates that you
select. You get summary information about each feature, and you can also click a feature name or
download a spreadsheet to get more details.
You can also open and download predefined reports for all products, to see all the features from the
past two years, all the Redwood features, or all the features with AI.
 

<Product Category> What’s New documents that provide details about the features in a specific product and release
update. To see which features are delivered disabled or enabled by default, click Feature Summary in
the table of contents.

Features with Opt-In Expiration List of features where the current option to opt in won’t be there in the future. See when each feature
will no longer be optional.
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14  Preferences

Set Your General Preferences  
You can set your general preferences such as, language, currency, time zone, accessibility, and watchlist. Use the
General Preferences section in the Set Preferences work area to set your general preferences.

To set general preferences:

1. Click Navigator > Tools > Set Preferences.
2. From the General Preferences list, select the preference you want to set.
3. Update and save your preferences.

Set Language Preferences  
Use the General Preferences: Language page of the Set Preferences work area to set your language preferences.

To set language preferences:

1. Click Navigator > Tools > Set Preferences.
2. From the Default list, select the language you want to set as the default language. Your entire application and

all its elements, such as UI text, page names, and field names are displayed in this language. The input data for
fields will not be translated automatically to the selected language.

Note:  If the languages you want to set aren't available on the General Preferences: Language page, contact
your help desk.

3. From the Current Session list, select the language to be used in the current session until you either log off or
change your language preference.

4. From the Display Name list, select the language to be used for your display name in the global header.
For example, if your name is Christy, and you select Spanish for your display name, then your name will be
displayed as Christie. If the equivalent of a name doesn't exist in the preferred display language, or if the display
language isn't set, then the user names are displayed in the preferred default language.

Related Topics
• Examples of Process Options

Set Regional Preferences  
Use the General Preferences: Regional page of the Set Preferences work area to set your regional preferences. The
default values you see for each field on this page are set by your implementers. You can edit these values if required.

To set regional preferences:

1. Click Navigator > Tools > Set Preferences.
2. Select your regional preferences:
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◦ Territory

◦ Date Format

◦ Time Format

◦ Number Format

◦ Currency

◦ Time Zone

Note:  In the Time Zone list, if you see multiple options for a time zone, select the one that matches
your daylight saving time. For example, suppose you see both Phoenix and Denver with the same time
zone of UTC-07 and the difference is that Denver’s time zone will change for daylight saving. If you’re in
Boulder with UTC-07, which changes with daylight saving, you should use the Denver time zone.

3. Click Save and Close.

Change Your Photo  
People can see your profile photo on your public information page, in the directory search results, and the global
header. You can have only one profile photo at a time.

1. Go to the Personal Details page in Redwood.

Note:  You can also update your photo using the My Photo page in general preferences. Click your user image
or name in the global header and go to Personalization > Set Preferences > My Photo.

2. Click Browse and select the photo to upload. Keep these points in mind when selecting the photo:

◦ The file size should be less than 20 megabytes.

◦ The preferable file format is .png or .jpeg though other image file formats are also supported.

◦ Ensure that the image dimension is 90 x 120 pixels to avoid distortion. If the image isn't of this
dimension, try maintaining an aspect ratio of 3 x 4.

Note:  If the photo appears rotated after upload, check the orientation of the camera when the photo is taken.
If the camera is left-bottom aligned, then you might face this issue. Rotate the photo four times to correct the
alignment.

3. Click Save and Close.

Set Up the Accessibility Modes  
You can configure the accessibility modes of the application pages built with Oracle Application Development
Framework (ADF).

Note:  You don’t need to set up accessibility modes for pages built with Visual Builder Studio (Redwood pages) or
Oracle Application Express (APEX pages), as both platforms include built-in accessibility support.

1. In Preferences, click Accessibility Settings in the General Preferences section.
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2. If you rely on screen reader assistive technologies, switch to the Screen Reader mode. Selecting this mode
changes several aspects of the user interface. For example, tree components have additional columns that you
can use to select specific tree nodes.

3. If you run your operating system in a high contrast mode, such as black on white, switch the color contrast to
High.

4. Save your changes.

Related Topics
• Accessibility Features

• Overview of Application Accessibility

• What themes can I use in Fusion Applications?

Change Your Password  
Use the application link your company gave you to open the Sign In page and change your password for better security.
You can use either of these methods to change your password.

• After you sign in, you can change your password using the Set Preferences option.

• On the Sign In page, you can change your password using the Forgot Password link.

Change Your Password Using Set Preferences
1. Click your user image or name in the global header, and on the Settings and Actions menu, select Set

Preferences.
2. In the General Preferences section, click Password, and enter your password details.
3. Click Save and Close.

Change Your Password Using Forgot Password
1. On the Sign In page, click the Forgot Password link.
2. Enter the registered work email, select the Forgot Password option and click Submit.

A notification containing a link to reset your password is sent to your work email.

Note:
• If you don’t have your work email registered, the notification is sent to your line manager.

• If both you and your line manager don’t have work emails registered, you’ll not be able to reset your password.
Contact your security administrator to register your work email.

This table shows which method you can use for resetting passwords based on your Single Sign-On (SSO) configuration.

Password Reset Method to UseSSO Configuration

Set Preferences Option Forgot Password Link

SSO Disabled Yes Yes
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Password Reset Method to UseSSO Configuration

Set Preferences Option Forgot Password Link

SSO Enabled No No

SSO with Chooser Enabled (both SSO sign-in and local
authentication options are available)

No Yes

Set Up Multifactor Authentication Methods  
Setting up multifactor authentication (MFA) methods is either optional or mandatory for you, based on the environment
you're in. After a method is set up, you can use it as a second factor of authentication for signing in.

Enroll in MFA and Set Up Your First Authentication Method
1. Sign in to the application using your application user ID and password. If mandatory MFA applies to you, skip to

step 4.
2. Click your user image or name in the global header, and select Set Preferences from the Settings and Actions

menu.
3. Open your password preferences and click Manage Secure Verification.
4. Enable secure verification using any of the available methods. You go through this guided setup process only

when you're enrolling in MFA for the first time.

Method Action Required

Mobile App Use either of these modes.

◦ Set up the Oracle Mobile Authenticator App to send a push notification for allowing or
denying a sign in attempt.

◦ Set up the Oracle Mobile Authenticator App to generate a passcode.

Phone Number Verify using the one-time passcode that's sent to your phone number as a text message.

Email Verify your email address using the one-time passcode that's mailed to you.

Passkey Follow the on-screen instructions to configure a passkey for your device.

Note:  Your work mobile number and work email are used for the Phone Number and Email methods.
The mobile number and email are stored in Oracle Fusion Cloud Applications and not in Oracle Cloud
Infrastructure.

Set Up Additional Methods and Manage Them
After you enroll in a MFA factor, you can set up additional secure verification methods on the Security tab that opens in
Oracle Cloud Console. Any time after enrollment, you can click the Manage Secure Verification link in your password
preferences to return to the Security tab and set up additional secure verification methods or manage them.
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Bypass codes are available as an additional authentication option. You can generate a bypass code and save it for
later use, but you can use it only once. A bypass code comes in handy for you to sign in when your authenticator is
unavailable for any reason like lost service or no service. You can also contact your administrator to get a bypass code.

After entering the username and password, if you can't use the MFA factor that was enrolled earlier, select the Try
another way button to view the other MFA factors that are available for use. On selecting the Try another way button,
from the remaining MFA factors that are available for you, select the MFA factor that you can use to sign-in to the
application.

Select the Trust this device for 15 day(s) option to access the application without getting prompted to verify every time
you sign-in, for the specified number of days.

Related Topics
• Using the Oracle Mobile Authenticator App

• Using FIDO Authentication

• Generating a Bypass Code

Watchlist  

Set Watchlist Preferences  
Use the Watchlist page in the Set Preferences work area to enable or disable specific items or categories in your
Watchlist.

The preferences contain these items:

• All the predefined Watchlist categories and items available to you

• Any saved searches you're using as Watchlist items

Follow these steps to set your Watchlist preferences:

1. Click your user name or image in the global header, and go to Set Preferences > Watchlist.
2. Use the Enabled check box to show or hide any Watchlist item or category.

Note:  Disabling a category automatically hides all of its items.

3. Optionally hide enabled Watchlist items that show no records.

Related Topics
• Why are some items not displayed in my Watchlist?

• How can I rename Watchlist items?

• Create Watchlist Items

• Why is the count different between a Watchlist item and the page that the item link takes me to?
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Why are some items not displayed in my Watchlist?  
Items might be hidden based on your Watchlist preferences. These preferences also apply to saved searches that you're
using as Watchlist items.

To review your preferences, select your user name or image in the global header, and go to Personalization   > Set
Preferences   > Watchlist.

Here are some other possibilities:

• You deselected saved searches in the Manage Watchlist dialog box, so they're no longer used as Watchlist
items.

• You deleted saved searches that were used as Watchlist items.

• Your administrator disabled specific predefined Watchlist items or categories for all users.

• Your administrator disabled using saved searches (from specific pages) as Watchlist items.

• Your administrator revoked access to tasks or pages that used to be available to you.

In these cases, you can no longer see the corresponding Watchlist items in your Watchlist and in your Watchlist
preferences.

Related Topics
• Set Watchlist Preferences

• Create Watchlist Items
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15  Accessibility

Overview of Application Accessibility  
The application is designed with accessibility features that support assistive technologies, such as screen readers. You
can use the General Preferences: Accessibility page in the Set Preferences work area to set the accessibility modes of the
application.

For more information about Oracle's commitment to accessibility, see Oracle's Accessibility Program.

Related Topics
• Accessibility Features

• Set Up the Accessibility Modes

Accessibility Features  
You can use assistive technology products, such as screen readers, while you work in the application.

Certain components render differently in the screen reader mode. For example, date fields in the default mode have
a date picker. You can either use the date picker to choose a date, or manually enter the date as text. In screen reader
mode, you only enter information as text because date pickers aren't available.

You can also use a keyboard instead of a mouse. Here are some accessibility features:

• Skip navigation links

• Additional role and state labels

• Isolated display

• Content change announcements

• Alternatives actions to drag and drop

Skip Navigation Links
When you access a page and press the Tab key, the Skip to main content link appears. Use this link to skip the global
header and navigate directly to the filmstrip, which is the row of page entry icons before the page title.

Additional Role and State Labels
When you access a page in screen reader mode, the screen reader reads the labels of various user interface
components such as menus and buttons, including the role and state labels. These additional labels identify the
purpose and current state of the item. In some cases, the Web Accessibility Initiative - Accessible Rich Internet
Applications (WAI-ARIA) standards are leveraged for role and state information.
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Isolated Display
In screen reader mode, when you open a menu or a dialog box, the display is isolated on the open component until you
close it. For example, when you open the Actions menu, only the Actions Menu heading and menu items are displayed.
In addition to the menu item names, the isolated display provides contextual information for each item. For example,
each item has Menu Item or Menu as a suffix, with the latter identifying submenus that you can open. For dialog boxes,
the isolated display also provides additional information, for example to identify fields with invalid data entry.

Content Change Announcements
In screen reader mode, WAI-ARIA live regions announce changes to the application. For example, when you open or
close dialog boxes, you can hear the rendering of partial content, progression of progress indicators, or changes in the
menu and dialog box state.

Alternatives to Drag and Drop
Pages that provide drag and drop operations also support alternative methods of operation.

In tables where you can use drag and drop to move columns, you can select Reorder Columns from the View menu,
and move (or change) the order of the selected items.

Navigation Tips for Mobile Devices
After updating the fields on a page on mobile devices, to open additional action buttons such as Save or Save and
Close, tap the More Actions Ellipsis.

Related Topics
• Set Up the Accessibility Modes

Keyboard Shortcuts  

What keyboard shortcuts are available in Fusion Applications?  

You can use keyboard shortcuts to navigate the entire application and do user interface actions using only the keyboard,
so you don’t need a mouse or assistive technology. For example, you can use keyboard shortcuts to save a file or open a
tab. Keyboard shortcuts for specific UI elements vary depending on whether the page was built using Oracle Application
Development Framework (ADF) or Oracle Visual Builder Studio (VB Studio) or Oracle Application Express Components
(APEX).

To identify the type of page you’re using, look at the browser URL of the page.

• If the third segment contains faces, the page is built using ADF.

• If the third segment contains redwood, the page is built using VB Studio.

• If the second segment contains uix, the page is built using APEX.

Refer to this table to find keyboard shortcut topics based on your page type:
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URL Segment for Page Type URL Example Keyboard Shortcut Topic

faces (in the third segment) https://example.com/myApp/faces/Page1 Keyboard Shortcuts for Oracle Application
Development Framework Components

redwood (in the third segment) https://example.com/myApp/redwood/
Page1

Keyboard Shortcuts for Redwood Components

uix (in the second segment) https://example.com/uix/* Keyboard Shortcuts for Oracle Application
Express Components

You can also use keyboard shortcuts in other areas of the application. Use this table for quick references:

Application Area Keyboard Shortcut Topic

Home page Keyboard Shortcuts for Home Page

Work areas Keyboard Shortcuts for Work Areas

Infolets Keyboard Shortcuts for Infolets

Keyboard Shortcuts for Oracle Application Development
Framework Components  
Some application pages use Oracle Application Development Framework (ADF) components, which come with standard
keyboard shortcuts. You might also find different keyboard shortcuts specific to the page, feature, or product that you're
using.

Oracle ADF keyboard shortcuts are described in the Oracle Fusion Middleware Web User Interface Developer's Guide for
Oracle Application Development Framework.

Default Mode
• Refer to the following sections in the guide for the corresponding keyboard shortcuts.

See: Keyboard Shortcuts

◦ Shortcut Keys for Common Components

◦ Shortcut Keys for Widgets

◦ Shortcut Keys for Rich Text Editor Component

◦ Shortcut Keys for Table, Tree, and Tree Table Components

◦ Shortcut Keys for ADF Data Visualization Components

◦ Shortcut Keys for Calendar Component
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Screen Reader Mode
The keyboard shortcuts for some components in screen reader mode are different from the shortcuts in default mode.

• Refer to the following sections in the guide for the corresponding keyboard shortcuts.

See: Keyboard Shortcuts

◦ Shortcut Keys for Table, Tree, and Tree Table Components in Screen Reader Mode

◦ Shortcut Keys for ADF Data Visualization Components in Screen Reader Mode

◦ Shortcut Keys for Calendar Component in Screen Reader Mode

Related Topics
• Accessibility Features

• Overview of Application Accessibility

• Keyboard Shortcuts for Redwood Components

• Keyboard Shortcuts for Infolets

Keyboard Shortcuts for Redwood Components  
Some application pages use Redwood components, which come with standard keyboard shortcuts. You might also find
different keyboard shortcuts for complex UI actions and component-specific controls.

Frequently Used Keyboard Controls
This table summarizes the most common keyboard controls.

Key Action

Enter
 

• Trigger the activity, when the focus is on a link, an image, or a button with an associated URL or
activity.

• Toggle the focus or selection.

• For input fields and menus, submit or enter a typed value or select the highlighted item.

• In tables, make the current row editable or enter Actionable Mode.

 

Shift + Enter
 

For cells in editable tables, make the previous row editable and move the focus to the editable cell in
the current column of the previous row. If the first row is editable, make it read-only.
 

Space
 

• Trigger the activity, when the focus is on a link, an image, or a button with an associated URL or
activity.

• Toggle the focus or selection.

 

Shift + Space
 

In components such as Card View, Data Grid, List View, and Tree View, select contiguous items from
the last selection to the current item.
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Key Action

Ctrl / Cmd + Space
 

• Multi-select item with focus.

• In List View and Tree View, toggle the selection of the current item while maintaining previous
selections.

 

Tab
 

• Set focus to the first focusable element or cycle focus through next focusable elements.

• For some components, such as Card View, Data Grid, List View, Table, or Waterfall Layout, when
in Tabbable or Actionable Mode, if the focus is on the last element, the focus goes back to the
first focusable element. When not in Tabbable or Actionable mode, the focus goes to the next
focusable item on the page.

 

Shift + Tab
 

• Cycle focus through previous elements.

• For some components such as Card View, Data Grid, List View, Table, or Waterfall Layout, when
in Tabbable or Actionable Mode, if the focus is on the first element, the focus goes back to the
last focusable element. When not in Tabbable or Actionable mode, the focus goes to the previous
focusable item on the page.

 

Up Arrow
 

• Move focus and selection to previous item or scroll the content up.

• For drop-down lists, expand the list when closed.

• For numerical input fields, increase the number by one in the segment.

• For slider components, scroll right on horizontal sliders and up on vertical sliders.

 

Down Arrow
 

• Move focus and selection to the next item or scroll the content down.

• For drop-down lists, open the list when closed.

• For numerical input fields, decrease the number by one in the segment.

• For slider components, scroll left on horizontal sliders and down on vertical sliders.

 

Left Arrow
 

• Move focus and selection to the previous item or the item on the left. Also, can scroll the content
left.

• For collapsible groups inside collection components, collapse the current expanded item.

• For slider components, scroll left on horizontal sliders and down on vertical sliders.

 

Right Arrow
 

• Move focus and selection to the next item or the item on the right. Also, can scroll the content
right.

• For collapsible groups inside collection components, expand the current item if it has children.

• For slider components, scroll right on horizontal sliders and up on vertical sliders.

 

Shift + Arrow
 

For selectable elements within collection components, move focus and extend the selection in the
direction of the arrow.
 

Shift + Ctrl / Cmd + Arrow
 

In Card View, reorder the current item in the direction of the arrow.
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Key Action

F2
 

• For some components, such as Cards, Data Grid, List View, Table, or Waterfall Layout, enter
Tabbable or Actionable Mode allowing navigation and use of controls in the item.

• Exit Tabbable or Actionable Mode.

 

Alt + F10
 

For Rich text input, move focus to the text editing toolbar.
 

Esc
 

• Exit Tabbable or Actionable Mode.

• Collapse drop-down lists.

 

= or +
 

Zoom in one level (if zooming is enabled).
 

- or _
 

Zoom out one level (if zooming is enabled).
 

Page Up
 

For Data grid and data visualization components, such as Diagram and Timeline, pan up (if scrolling is
enabled).
 

Page Down
 

For Data grid and data visualization components, such as Diagram and Timeline, pan down (if scrolling
is enabled).
 

Shift + Page Up
 

• For Data grid and data visualization components, such as Diagram and Timeline, pan left (in left-
to-right locales).

• Pan right (in right-to-left locales).

 

Shift + Page Down
 

• For Data grid and data visualization components, such as Diagram and Timeline, pan right (in
left-to-right locales).

• Pan left (in right-to-left locales).

 

Home or End
 

For Data grid, move focus to the first or last focusable item.
 

Ctrl / Cmd + X
 

For draggable elements, mark the selected items to move if reorder is enabled.
 

Ctrl / Cmd + C
 

For draggable elements, mark the selected items to copy if reorder is enabled.
 

Ctrl / Cmd + V
 

For draggable elements, paste selected items directly before the current item (or as the last item if the
current item is a folder).
 

Del / Backspace
 

For removable selected elements, such as Chips and Tabs, delete the selected element.
 

Component-Specific Keyboard Controls
Some components use additional or alternative keyboard controls. For more details, review the specific component
information on Oracle JavaScript Extension Toolkit (JET) Keyboard and Touch Reference.
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Related Topics
• Keyboard Shortcuts for Oracle Application Development Framework Components

Keyboard Shortcuts for Oracle Application Express Components  
Some application pages use Oracle Application Express (APEX) components, which come with standard keyboard
shortcuts. You might also find different keyboard shortcuts for component-specific controls.

For information, see Keyboard Shortcuts for Oracle APEX.

Keyboard Shortcuts for Home Page  
You can use keyboard shortcuts to navigate on the home page or go to specific work areas.

This table lists the keyboard shortcuts for home page navigation.

Action Shortcut

Open tabs, such as Me, My Team, and
Tools
 

After you sign in and press the Tab key, the Skip to main content link appears. Press the Enter key
to directly navigate to the first tab stop. You can then use the arrow keys (left and right) to navigate
through the tabs.
 

Open the Navigator and the Settings and
Actions menu
 

Press the Tab key to navigate to the next element.
 

Open specific work areas When the focus is on a tab, such as Me and My Team, press the Enter key to display a set of work area
icons and quick actions for a related set of tasks. Press the Tab key to navigate through the work area
icons and quick actions. Press the Enter key to open a specific work area or quick action.
 

Move to the previous element on the page
 

Press the Shift + Tab key to navigate to the previous element.

Related Topics
• Overview of Application Accessibility

• Set Up the Accessibility Modes

• Keyboard Shortcuts for Redwood Components

• Sign In and Get Started

• Keyboard Shortcuts for Oracle Application Development Framework Components

Keyboard Shortcuts for Work Areas  
You can use keyboard shortcuts to go to specific work areas and do the required task on the work area pages.
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This table lists the keyboard shortcuts for work areas.

Action Shortcut

Open tabs, such as Me, My Team, and
Tools
 

After you sign in and press the Tab key, the Skip to main content link appears. Press the Enter key
to directly navigate to the first tab stop. You can then use the arrow keys (left and right) to navigate
through the tabs.
 

Open specific work areas When the focus is on a tab, such as Me and My Team, press the Enter key to display a set of work area
icons and quick actions for a related set of tasks. Press the Tab key to navigate through the work area
icons and quick actions. Press the Enter key to open a specific work area or quick action.
 

Submit your changes in work areas
 

After updating the fields on a page, press the Tab key until the focus is on the Submit button. You can
do either of these steps:
 

• Press the Enter key to click the Submit button.

• On the Submit button (which is focused), the letter, m is underlined, which indicates that the
keyboard shortcut to use that button is Alt+m. So, press Alt+m to submit your changes.

Save your changes in work areas After updating the fields on a page, press the Tab key until the focus is on the Save button. You can do
either of these steps:
 

• Press the Enter key to click the Save button.

• On the Save button (which is focused), the letter, S is underlined, which indicates that the
keyboard shortcut to use that button is Alt+s. So, press Alt+s to save your changes.

Cancel your changes in work areas
 

After updating the fields on a page, if you want to discard your changes, press the Tab key until the
focus is on the Cancel button. You can do either of these steps:
 

• Press the Enter key to click the Cancel button.

• On the Cancel button (which is focused), the letter, C is underlined, which indicates that the
keyboard shortcut to use that button is Alt+c. So, press Alt+c to cancel your changes.

Keyboard Shortcuts for Infolets  
You can use keyboard shortcuts to operate the infolets on the home page or specific work areas. The shortcuts might be
different from the ones listed in the following table depending on the selected infolet.

This table lists the keyboard shortcuts for infolets.

Action Shortcut

Move focus backward among the
components in the page
 

Shift + Tab
 

Open a context menu where available
within a template in the page
 

Alt + Arrow Down
 

Open the different components in a chart Ctrl + Arrow
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Action Shortcut

  

Select and deselect the checkbox in My
Infolets
 

Spacebar
 

Open links except those in charts
 

Enter
 

Open links in the templates with charts
 

Arrow
 

Close dialog box
 

Esc
 

Related Topics
• Overview of Infolets

• Overview of Application Accessibility

• Keyboard Shortcuts for Redwood Components

• Set Up the Accessibility Modes

• Keyboard Shortcuts for Oracle Application Development Framework Components
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